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Introduction 

**This Tutorial and User Guide is compatible with Workbench Beta v0.83** 
 
Connectome Workbench (herein called ‘Workbench’) is a freely available software platform for 
visualization and analysis of neuroimaging data.  It is customized for handling data from the Human 
Connectome Project (HCP), including functional and structural connectivity and task-fMRI, using 
combined surface and volume visualization.  
 
To get Workbench, users can download Mac, Windows, and Linux versions from the HCP website (see 
Downloading Connectome Workbench beta v0.83 below). Getting the HCP-generated data necessary to 
complete this tutorial requires a few more easy steps. To get the data, users must sign up for an account 
on ConnectomeDB and agree to the HCP Open Access data use terms before downloading (see 
Downloading Tutorial Data below).  
 
This tutorial is written for users at all levels, from those new to brain mapping to regular users of FSL, 
FreeSurfer, Caret, and other brain-mapping platforms.  Workbench has its roots in Caret software 
developed by the Van Essen laboratory, but it has been thoroughly re-designed and re-implemented.  
Novel features of Workbench include: 
 

• Interactive viewing of functional connectivity 
• Improved user interface for selecting data layers and maps 
• Viewing fMRI time courses and other data series frame-by-frame or as movies 
• Options to display multiple surfaces and volumes as tabs, windows, or as a “montage” within a 

single window 
• Compatibility with NIFTI, GIFTI, and the new ‘CIFTI’ (surface + volume) data formats. 
• Interactive viewing of structural connectivity and probabilistic fiber trajectories (coming soon!) 

 
You are encouraged to use this tutorial however it suits your experience level and learning style:  You 
can run through the full tutorial as written or skip around to sections covering features of particular 
interest. ‘Scenes’ files, which provide a ready setup of data to show particular features, facilitate 
skipping between sections of interest (each scene has a separate section in the tutorial). Those who 
have not previously used Caret software may find it easier to begin with Chapter 2, which covers 
Workbench features more methodically and systematically. Another option for getting a quick look at 
HCP data released in Q1, while learning Workbench basics, is to follow the Tutorial for Q1 Unrelated 20 
Dataset (v1b) included as an Appendix to this document.  
 
Chapter 1 (Exploring HCP Data in Workbench) is a tutorial designed to get you exploring the different 
types of data offered by HCP “get your feet wet” tutorial demonstrating major features of the user 
interface, including interactive viewing of functional connectivity maps. It uses extensively processed 
individual and group average data from the HCP Quarter 1 (Q1) data release (March 2013) (see 
ReleaseNotes_HCP_Q1_GroupAvgUnrelated20_v1b.txt included in the tutorial distribution). Estimated 
time to complete: 40-60 minutes. 
 

http://www.humanconnectome.org/
https://db.humanconnectome.org/app/template/Login.vm
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-NIFTI
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-GIFTI
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-CIFTI
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Chapter 2 (Detailed Guide to the Workbench User Interface) is a more comprehensive feature-by-
feature tour of major Workbench visualization tools and is a good starting point for capitalizing on the 
full range of Workbench capabilities.  It is complemented by the Workbench Help Guide, an online 
resource on the publically accessible HCP wiki.  
Estimated time to complete: approximately 1 hour   
 
Chapter 3 (Using Workbench Tools) describes how to draw/edit borders and foci, display average 
connectivity within a border, and create Regions of Interest (ROIs). 
 
Chapter 4 (Using wb_import and wb_command) introduces some basic functions of these Workbench 
command line programs, including converting files to workbench format and creating spec files.   
 
Appendix (Tutorial for Q1 Unrelated 20 Dataset (v1b)) introduces you to very basic functions in 
Workbench, while highlighting structural, resting state and task data made available as part of the HCP 
Q1 data release (see http://humanconnectome.org/data/ for more information on HCP data releases). 
Estimated time to complete: 30 minutes  
 
Future chapters will describe additional tools in Workbench, including visualizing diffusion imaging data 
(fiber orientations, probabilistic fiber trajectories, and structural connectivity).   
 
Connectome Workbench is under active development, with many new capabilities to be added in 2013. 
We encourage user feedback to help identify and prioritize refinements and needed features (Feature 
requests can be directly submitted through the Help Menu). The HCP-users public discussion email list is 
an open forum for discussing such issues.  You can join via 
http://www.humanconnectome.org/contact/#subscribe.  Once you have subscribed, you can set 
preferences to receive hcp-users postings to the list as individual messages or as a digest. Please send 
bug reports and suggestions to the list by emailing hcp-users@humanconnectome.org. 

ConnectomeDB and Tutorial Data 
In addition to handling locally stored data files (like those distributed with this Tutorial and User Guide), 
Workbench can access data files stored in ConnectomeDB, the web-accessible database that houses all 
HCP data modalities available for download (MRI, MEG, and behavioral data).  The interactivity between 
Workbench and ConnectomeDB will be increasingly critical, given the complexity of the datasets and the 
large file size for some data types (e.g., ‘dense connectome’ files currently exceed 30 GB per subject).  
To circumvent downloading of these large files, connectivity maps for user-selected subjects and regions 
of interest can be extracted on the fly from ConnectomeDB and transmitted within seconds to 
Workbench through an internet connection.  

For this tutorial, using Workbench Beta v0.83, the Workbench interaction with ConnectomeDB involves 
a single step: opening a dense connectome file from ConnectomeDB through the Open Location option 
in the File menu (see Viewing Functional Connectivity below).  

• This tutorial uses dense functional connectome data that are for demonstration purposes only. 
(This restriction is necessary because the advanced methods used to analyze the connectivity 

http://www.humanconnectome.org/
https://wiki.humanconnectome.org/display/WBPublic/Connectome+Workbench+Help+Guide
http://humanconnectome.org/data/
http://www.humanconnectome.org/contact/#subscribe
mailto:hcp-users@humanconnectome.org
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-ConnectomeDB
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-DenseConnectome
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data have not been published or fully vetted).  This restriction does not apply to the group-
average task fMRI, myelin maps, and other surface and volume data that are part of the tutorial 
dataset. 

• Unprocessed and minimally processed HCP image data and behavioral data is available for 
download and can be used freely by anyone who registers and accepts the Open Access Data 
Use Agreement at http://humanconnectome.org/data/.  

Downloading Connectome Workbench beta v0.83  
** Skip this section if you have already downloaded and installed Workbench v0.83 (released August 
2013). You are ready to get started! 

Mac, Windows, and Linux versions of Connectome Workbench beta v0.83 are available for download as 
zipped file archives from the Workbench download page on the HCP website. 

Operating system requirements for Workbench: 

* Mac 64-bit: Snow Leopard (OS X 10.6.X or later) 

* Linux 64-bit: Ubuntu 8.04 LTS or later, CentOS 6.2 or later and RHEL (Red Hat Enterprise Linux) version 
6 or later (may run on earlier systems, but this is not supported)  

* Windows 64-bit: Windows XP SP3 or later  

Download Instructions:  

• Download Workbench for 64-bit MacOSX, 64-bit Linux, or 64-bit Windows operating systems (in 
a zipped folder containing all necessary libraries) from the Workbench download page. 

• Unzip the folder. A subdirectory named ‘workbench’ will be created.  

• Move the ‘workbench’ folder to your Applications, Program Files folder, or other designated 
directory. Within the ‘workbench’ folder, is a ‘bin’ folder (named bin_[operating system]) that 
contains the executables for the workbench application and ‘wb_command’ and ‘wb_import’ 
command-line utilities.  If desired, make a short-cut icon to the program executable for your 
dock or desktop. For the mac64 version, the 'app' for workbench is in 
workbench/macosx64_apps/workbench.app 

• To run Workbench from a terminal window using the command line, you need to set your PATH 
environment variable to the appropriate directory. 

For Mac users: If you moved the unzipped Workbench folder to Applications, set your PATH to:  
/Applications/workbench/bin_macosx64 

For Linux users: Set your path to whatever directory you placed the unzipped Workbench folder.  

To set the PATH in Bash shell, enter this command in a terminal window: 
> echo 'export path=$path:/my/workbench/path' >> ~/.bashrc 

http://www.humanconnectome.org/
http://humanconnectome.org/data/
http://humanconnectome.org/connectome/get-connectome-workbench.html
http://humanconnectome.org/connectome/get-connectome-workbench.html
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To set the PATH in tcsh/csh shell, enter this command in a terminal window: 
> echo 'set path = ($path /my/workbench/path)' >> ~/.cshrc 

where “/my/workbench/path” is the directory that contains the Workbench folder. 

Log out and log back in to make the change take effect. 

Downloading Tutorial Data  
Downloading the HCP-generated neuroimaging data necessary to complete this tutorial is easy, but 
requires a few more steps. Briefly, to get the data, users must have an account on ConnectomeDB, have 
agreed to the HCP Open Access data use terms, and have installed the Aspera Connect plugin in their 
browser.  
 
Because of the large size of the data, downloading is facilitated through an Aspera server that requires 
you to have the Aspera plugin installed in your browser (available free to end users). Before you start 
the download process, if you have not installed the plugin yet, a warning message will appear at the top 
of your browser when reminding you that you must Install the Aspera plugin before downloading. 
 
Pre-download instructions: 

• Follow this link to install the Aspera Connect plugin for your browser. 
 
Download instructions: 

• Click the Tutorial Data button the Workbench download page. 

• Instructions outlining the steps for this download process will popup. 

• Click on the Go to ConnectomeDB login button. You will be taken to the ConnectomeDB login 
page.  

o If you have a ConnectomeDB account, enter your username/password and press Log In. 

o If you do not have an account, click the Register button to create one. 

 Click the link in the verification email that is sent to the email address you 
provided in registration. 

 Log in with your username/password. 

• The ConnectomeDB splash page will open. 

o If you have not yet signed the HCP Data Use Terms, the page will show a 
button on the right side containing the words “Please sign Data Use 
Terms to access”. Click the button. 

 The Open Access Data Use Terms will popup. 

 Click each checkbox to agree to each Data Use Term. When you have accepted 
each term, the checkbox on the bottom left will be checked. 

 Click the Complete Registration button. 

http://www.humanconnectome.org/
https://db.humanconnectome.org/app/template/Login.vm
http://downloads.asperasoft.com/download_connect/
http://downloads.asperasoft.com/download_connect/
http://humanconnectome.org/connectome/get-connectome-workbench.html
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o Having signed the HCP Data Use Terms, now scroll down the page to the Connectome 
Workbench Data section of the ConnectomeDB splash page and click the Download 
Tutorial Dataset button.  

 If you have the Aspera Connect plugin installed, the download of the tutorial 
data will launch on your browser. 

 If you do not have Aspera Connect installed you will see a warning message at 
the top of your browser with the link to the Aspera site.  

• Unzip the HCP_WB_Tutorial_Beta0.83 zipped archive you just downloaded. 

The HCP_WB_Tutorial_Beta0.83 folder contains a copy of these tutorial instructions and all the data 
files necessary to complete this tutorial, packaged in the same directory. You are ready to start the 
tutorial! 

Tutorial Conventions 
Some conventions in this document: 

• All tutorial steps are identified by bullets. 
• Actions the user should take are in italics.  
• Click refers to a left click with the mouse unless otherwise indicated. 
• User-interface components and file names are in bold. 
• Some instructions are streamlined using arrows (e.g. Toolbar►L means press the L button in the 

Toolbar or File Menu►Open File means select the item Open File from the File Menu). 
• Technical terms highlighted in blue are defined in the online Workbench Glossary.  The 

Workbench Glossary is also appended to this tutorial.   
• All figures were made using the Mac OSX version of Workbench. The PC and Linux user 

interfaces appear slightly different, but the functionality is the same. 

Launching Connectome Workbench 
• Microsoft Windows: double-click the Workbench icon on the desktop or in your Program files 

folder. 
• Mac OSX: click the Workbench icon in the dock or in your Applications folder. 

• Linux (or Mac terminal): change (cd) to the HCP_WB_Tutorial_Beta0.83 directory in a terminal 
window, then enter workbench and press Return. 

http://www.humanconnectome.org/
http://downloads.asperasoft.com/download_connect/
https://wiki.humanconnectome.org/display/aWB/Workbench+Glossary#WorkbenchGlossary-Toolbar
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary
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Figure 1.2 - The Open File 
Dialog  
 

 
Figure 1.1 – Connectome Workbench Splash Screen 
 

Chapter 1: Exploring HCP Data in Workbench 

Workbench Orientation 
This section provides a quick orientation to Workbench (and its associated file types) while exploring 
individual and group average data from the HCP that is currently available for download. 

Workbench Splash Screen 
When you launch Workbench, a splash screen opens (Figure 1.1), showing a list of Specification files 
(herein called “Spec Files”) in the directory path you are currently opening Workbench from, plus 
Recently opened Spec Files, if you have launched Workbench before.  

A Specification File contains an organized set 
of data files for loading into the program at 
once (e.g., surface, volume, ‘label’, and 
‘metric’ files).  

• For now, click the Skip button to 
launch Workbench without opening 
a file. 

Opening a Spec File and Loading Scenes 

• In the Workbench Menu bar, located at the top of your 
screen (Mac) or top of the blank Workbench window that 
just opened (Linux/PC), select File►Open File… (shortcut for 
Mac: command + O, Linux/PC: control + O) to display the 
Open File Dialog.  

• In the Open File Dialog (Figure 1.2), Navigate to the folder or 
directory that contains the data, the 
HCP_WB_Tutorial_Beta0.83 folder.  

o The default file type filter is Specification Files 
(*.spec). 

o Note: if you started from a terminal window in the directory containing the tutorial 
dataset, the tutorial spec file would already be available. 

• Select the desired file: HCP_beta0.83_tutorial.32k_fs_LR.wb.spec and click the Open button. 
The Open Spec File Dialog (Figure 1.3) will appear, showing the 43 files in this particular spec 
file, grouped into 8 types: Border, Dense Data Series, Foci, Label, Metric, Scene, Surface, and 
Volume.  

http://www.humanconnectome.org/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-SplashScreen
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-SpecFile
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-Menubar
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Figure 1.4 – The Scenes box   

 
Figure 1.3 - The Open Spec File Dialog  

• At the very top of the Open Spec File 
Dialog, click Border next to View File 
Types: The list of files below will be 
filtered to only show Border files. The 
View Structures: row similarly filters the 
files by Structure. 

Note: The data in this file includes 
surface and volume files from individual 
participant 249947 and from the 
population-average of data obtained 
from 20 healthy unrelated individuals in 
the HCP Q1 dataset.  

• Click Load Scenes at the bottom left of 
the dialog to open the scene file 
necessary for the tutorial. The 
Specification File Dialog will 
automatically close once the scene file is 
loaded (a few seconds).  

Often views in Workbench require several steps to set up, so we have provided scene files that offer 
a quick way to load views that show off the HCP data provided and many features of Workbench.  

• The Scenes box (Figure 1.4) will appear with 
HCP_WB_Tutorial_Beta0.83_part1.scene file 
displayed. In the Scenes field our first scene: “1. 
Individual surfaces and volumes” should be 
highlighted, indicating that it is selected.  

• Click Show to load the scene (may take several 
seconds).  

• Click Close to close the Scenes box. 

  

http://www.humanconnectome.org/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-Scene
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-Scene


 

Connectome Workbench beta v0.83 Tutorial and User Guide | WU-Minn Consortium of the HCP Page 11 

   A                     B 

         
     Figure 1.5 - The Workbench Viewing Window A) Vertical Orientation B) Horizontal Orientation  

Scene 1: Individual surfaces and volumes 
This scene is set up to show brain surfaces and volumes of an individual subject (subject 249947) 
scanned as part of Phase 2 (Final production phase) of the HCP. We are starting with an individual to 
give you a sense of the kind and quality of data generated at the single-subject level. It also provides a 
convenient backdrop to introduce you to the layout and some of the general features of Workbench.  

Workbench Window Layout 
The scene opens with the left hemisphere anatomical midthickness cortical surface (halfway between 
the pial and white matter surfaces) of the HCP Phase 2 subject 249947 in the Viewing Area of the 
Workbench Window (“Connectome Workbench 1”). Components of the Workbench Window are shown 
in Figure 1.5.  

The Workbench Window contains five Viewing tabs: (1) Cortex Left, (2) Cortex Right, (3) Montage, (4) 
Volume, and (5) All. (You may not see the 5th until the window is enlarged.)  

The Viewing Area opens viewing tab 1 (the Active Tab) showing the left cerebral cortex surface. We will 
browse all the tabs now and go through them in further detail below. 

• Click on Tab (2), which shows a myelin map overlaid on the inflated right cortical surface.  

• Click on Tab (3). This shows a montage of lateral and medial views of both left and right 
hemispheres of individual 249947.  

• Click on Tab (4). This shows parasagittal, coronal and axial T1-weighted volume slices of this 
individual. The colored outlines demarcate the pial, midthickness, and white matter boundaries 
in this individual.  

http://www.humanconnectome.org/
http://humanconnectome.org/about/project/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-ViewingArea
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-WorkbenchWindow
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-ViewingTabs
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-ViewingArea
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-ActiveTab
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• Click on Tab (5) All. This view shows the midthickness surfaces of both hemispheres and all 3 
volume planes (parasagittal, coronal, axial).  

• Click through the tabs again and notice that the Toolbar changes when you switch tabs/views. 

The Overlay Toolbox (where one sets data layers for viewing on structures) can be displayed in two 
locations/orientations: on the left or on the bottom of the Viewing Area, Figure 1.5A and B. On startup, 
the choice is automatically made based on the resolution of your monitor (if the vertical resolution is 
800 or less, the overlay toolbox will be on the left).  

For the purposes of this tutorial, all instructions and figures assume you are using the horizontal 
orientation layout (Figure 1.5B), with the Overlay Toolbox attached to the bottom of the Viewing Area.  

• Click back to Tab (1) CortexLeft.  

• Press the left mouse button and drag your mouse anywhere in the Viewing Area to rotate the 
surface.  

• To zoom, scroll your mouse wheel up and down anywhere in the Viewing Area. If you don’t have 
a mouse wheel, press the command (Mac)/control (Linux/PC) key while pressing the left mouse 
button and moving your mouse up and down. 

Toolbar 
The Toolbar at the top of the Viewing Window contains display settings for the brain structures you 
are viewing.  

• Clicking the Orientation buttons (right), you can display the surface in 6 standard 
views: L (Lateral), M (Medial), D (Dorsal), V (Ventral), A (Anterior), P (Posterior). Click 
the Reset button to reset to the lateral view at the original zoom setting. 

The Brain Structure and Surface (Selection) section of the Toolbar lets you switch brain structures and 
also surface configurations.  

If you accidentally left clicked on the brain surface, you have discovered the Information box. Just click 
on Close at the bottom of the box to remove (the Information box is described in more detail below). 

If you left click and drag the top of the Overlay Toolbox, it can be pulled off their docking points in the 
Workbench Window to float any place on your desktop.  As you do this, the images in the Viewing 
Area will resize to fill the Workbench Window. This is one convenient way to quickly get a larger view 
of the structures being displayed.  

Double click on the top of the Overlay Toolbox to make it return to its docked position. The same 
functionality is also available for the Features Toolbox (described in the sections on Scenes 6 and 7).  

http://www.humanconnectome.org/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-Toolbar
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-OverlayToolbox
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-Toolbar
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-FeaturesToolbox
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• Click on the lower dropdown  
(currently showing 249947.L.midthickness.32k_fs_LR.surf.gii). 

• The different surface configurations available for subject 249947 are shown (midthickness, 
inflated, very inflated, pial, white) along with the group average surfaces (midthickness, inflated, 
very inflated) available for the HCP Q1 Unrelated 20 subjects (more on the Q1 Unrelated 20 data 
in Scene 2: Individual vs. Group Avg surfaces).  

• Now, right click on the same lower dropdown and press your up and down arrow keys to browse 
through all the selections from both the individual and group surfaces.  

Surface Layers 
• Click on the second tab (2) CortexRight at the top of the Workbench Window to switch the view 

to the right hemisphere. This tab is set to display the inflated right hemisphere surface of 
subject 249947 with the top layer displaying a map of myelin content.  

• Rotate the surface (press the left mouse button and drag your mouse). Red and orange 
represent heavily myelinated regions, purple and black represent areas of low myelin content 
(Glasser & Van Essen, 2011).  

• Move the cursor down to the Overlay Toolbox below the Viewing Area. There are 5 tabs in the 
Overlay Toolbox. You are currently viewing the Layers tab. 

Layers are arranged like a layer cake—the topmost layer to be displayed on the surface is listed first, 
the one below it second, etc. The ‘On’ toggle on the left controls whether a layer is currently 
displayed, here, layer 1 is toggled off.  

In this case, a FreeSurfer generated parcellation LABEL file is listed on top (but is toggled off), the 
second layer is the CIFTI SCALARS ‘myelin’ file that you are viewing, and the third layer is a CIFTI 
SCALARS file representing cortical shape based on sulcal depth. These CIFTI scalars files contain 
scalar surface data for both left and right hemispheres (if data is available, CIFTI files can also 
contain surface data for cerebellar vertices and volume data for subcortical gray matter voxels).  

• Click the checkbox to the left of the top layer to turn it on and show the Freesurfer defined 
parcellation layer: CIFTI LABELS 249947.aparc.32k_fs_LR.dlabel.nii. Now change this top layer 
by clicking the label file field and clicking the CIFTI LABELS 
parcellations_VGD11b.L.32k_fs_LR.dlabel.nii file. This is a composite cortical parcellation based 
on architectonic or retinotopic fMRI maps (Van Essen et al. 2011b). 

• Now toggle the top layer off again to expose the myelin map.  

Whenever you encounter any dropdown menu in Workbench, you can right click the menu and 
quickly browse through selections using your up and down arrow keys, or search through selections 
by name by typing the first letter of what you are looking for.    

http://www.humanconnectome.org/
http://www.jneurosci.org/content/31/32/11597.long
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-Parcellation
http://cercor.oxfordjournals.org/content/early/2011/11/02/cercor.bhr291.long
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Figure 1.6 – Vertex Identification and the Info Box 

• Click the P button for a posterior view in the Orientation section of the Toolbar, then click the L 
button for a lateral view.  

o There is heavy myelination in much of the occipital lobe, including the orange-yellow 
patch around where area MT should be, near the occipito-temporal junction—lower left 
in lateral view.  

• Click on the surface within this patch over area MT (see Figure 1.6).  

• The Information box will pop up.  

• In the Viewing Area, a 
white sphere has appeared 
at the brainordinate (i.e. 
surface vertex or volume 
voxel) you selected.  Your 
viewing window should 
look like Figure 1.6.     

• In the Information box, 
information on the 
brainordinate that you 
clicked is listed. For 
example, the XYZ 
coordinates and the labels 
assigned to the identified 
vertex are shown.  

Information (e.g. metric values, label names) on the vertex you selected is pulled from all 
currently loaded files that contain data for the structure being viewed (right hemisphere), 
whether or not they are currently being displayed.  

• Toggle the top parcellation layer back on, and note that the vertex you identified in the myelin 
map is in the red patch defined by area MT in the VGD11b parcellation map.  

• Click on several more places on the surface. Each time you click, information on the newly 
identified vertex appears at the bottom of the listed information in the Information box.  

• Notice that the last vertex you clicked appears larger than the ones you clicked earlier. 

• Click the Properties button on the right side of the Information box to open the Symbol 
Properties box to change the color or size of the earlier and most recently identified ID spheres.  

• Change the ID symbol color to Blue. Click Close.  

You can move the placement of the Information box by dragging the top of the box to the desired 
position on your desktop. This position is saved when you close the box and remains where you set it, 
even between WB sessions.  

http://www.humanconnectome.org/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-Brainordinate
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• Click the Clear button at the top left of the Information box to clear all the information in the 
box, without removing the identified vertices from the surface. 

• Click a few more places on the surface. 

• Click the RID button (short for ‘Remove ID’) to remove all the identified nodes on the surface 
and all the ID information in the Information box.   

• Click the Close button at the bottom right of the Information box. The Information box will stay 
closed until you identify another brainordinate. If you don’t want the Information Box popping 
up every time you click a brainordinate, you can move it to the background (behind the 
Workbench Window) by clicking the Information box icon              in the upper right of the 
Workbench Window. 

Montage View 
• Click on the third tab (3) Montage at the top of the Workbench Window to switch the view to 

display lateral and medial sides of both the left and the right hemisphere cortical surfaces. Here, 
we are looking at a sulcal depth map on the midthickness surface of subject 249947. You can 
readily appreciate the differences in cortical folding between the hemispheres in this view. 

• Click a few places on the left hemisphere lateral surface (upper left) to see highlighted 
brainordinates in blue (if you changed the ID symbol color to blue in the Surface Layers section 
above). The Information box should popup, if not, click the Information box icon to bring it back 
to the foreground.   

• In the right side of the Information box click the Contra ID button (short for ‘Contralateral 
identification’). 

• Click again anywhere on the left hemisphere lateral surface. Now, a blue sphere will appear 
where you clicked and a green sphere will appear in the geographically corresponding location 
on the right hemisphere lateral surface (upper right).  

• Click on the right hemisphere medial surface (bottom right) and note a green sphere appears on 
the corresponding location on the left hemisphere medial surface.  

• Notice the checkboxes labeled “Left” and “Right” at the top of the Montage Selection section of 
the Toolbar. You can use these to toggle the left or right surfaces on and off. When you do this, 
the surfaces resize to fill the available viewing space. You may need to resize your Workbench 
Window or zoom out if you don’t want the montage surfaces to overlap.  

You can hide or show the Information box, Scenes box, Toolbar, Overlay Toolbox, or Features 
Toolbox by clicking the icon buttons for each of these located in the upper right corner of the Viewing 
Window. As you do this for the Toolbar, Overlay Toolbox, or Features Toolbox, the images in the 
Viewing Area will resize larger or smaller to fill the Workbench Window.  

http://www.humanconnectome.org/
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• The checkboxes at the left side of Montage Selection allow you to toggle up to two selected 
surfaces on and off. Click the bottom checkbox to toggle on the very inflated surfaces.   

• Turn the surfaces and see that they all move together in a yoked fashion. 

• Click RID in the Information box. Click the Close button. 

Volume View 
• Click on the fourth tab (4) Volume at the top of the Workbench Window to switch the view to 

display parasagittal, coronal, and axial (horizontal) volume views of subject 249947. In each 
slice, the pial surface is outlined in blue and the white matter/gray matter boundary is outlined 
in fuchsia (left hemisphere) and yellow (right hemisphere).  

o These are T1 weighted (T1w) volume slices at the slice indices indicated in the Slice 
Indices/Coords section of the Toolbar. 

o Click the vertical ORIGIN button at the right side of the Slice Indices/Coords section of 
the Toolbar to reset the slice planes (when you clicked on the surface in the previous 
section the volume planes moved to the planes containing the vertex you clicked). 

o Click on the “P” slice index field in Toolbar: Slice Indices/Coords. 

o Scroll up and down to move through the parasagittal slices. Try this function on the 
coronal and axial slices. 

• Toggle the T1w (first layer) off and the T2w (second layer) volume on in the Overlay Toolbox 
Layers tab. Now you are viewing the T2 weighted volume slices. 

• Click on the Vol/Surf Outline tab at the top of the Overlay Toolbox.  

• Toggle off the pial and white matter surface outlines. If you don’t see these listed, scroll down 
on the right side of the tab.  

• In the Viewing Area, zoom in on the slices to more clearly see the T2w data for this subject. 

• Click back to the Layers tab of the Overlay Toolbox. 

• Toggle the T1w top layer volume back on.  Toggle off/on to compare with the T2w layer below 
it.  

o In the T1 and T2 weighted volume data you see here, you can appreciate the 
exceptionally high quality and resolution we are achieving in HCP Phase 2.  

All (Whole Brain) View  
• At the top right of the Workbench Window, click on tab (5) All.  

• In the Orientation section of the toolbar, click the vertical RESET button.  

• Click the vertical ORIGIN button at the right side of the Slice Indices/Coords section 

http://www.humanconnectome.org/
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Figure 1.7 – All (Whole Brain) view 

• Drag the surface up and to the left to rotate the surface and volume (whole brain) and see that 
surfaces of both hemispheres and all 3 volume planes (parasagittal, coronal, axial) are visible 
(Figure 1.7).  

• Toggle the VOLUME… file (bottom 2 layers) off 
in Overlay Toolbox:Layers. 

• In the Toolbar: Surface Viewing section, change 
the surface from Anatomical to Inflated.  

• With your mouse cursor in the Viewing Area, 
zoom out.  

• To pan, or move the surface vertically or 
horizontally within the Viewing Area, hold down 
the shift key while pressing the left mouse 
button and moving your mouse side to side or 
up and down. 

 

  

http://www.humanconnectome.org/
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Scene 2: Individual vs. Group Avg surfaces and volumes 
• Reopen the Scenes Dialog by clicking the clapboard          button in the upper right of the 

Workbench Window. 

• Select “Individual vs Group Avg surfaces and volumes” and click Show to load the scene.  

This scene compares the Individual surfaces and brain volume of HCP Q1 subject 249947 with the group 
averaged surfaces and volume of 20 unrelated subjects in the HCP Q1 Unrelated 20 dataset.  

The scene opens with tab (1) Indiv Montage showing both hemispheres of the individual anatomical 
midthickness cortical surface of subject 249947. 

• Click on tab (2) Group Montage at the top of the Workbench Window. This tab shows the 
group-average midthickness surface of 20 individuals. 

• Click between tabs (1) and (2) to compare the surfaces.  

You can see the marked difference between the midthickness surface of the individual 249947 and this 
averaged midthickness derived from 20 subjects, each of which was registered to FreeSurfer’s fsaverage 
atlas surface. The group-average has convolutions similar to those of the individual in regions of 
consistent folding and a very different pattern in regions of high inter-subject variability. Group-average 
surfaces are important to the HCP and other brain mapping projects as a substrate that reflects common 
characteristics and avoids the bias of any individual subject.  

• Click on tab (3) Indiv Vol. This tab is showing a parasagittal slice plane view of the 249947 
individual T1 weighted volume. 

• Click on tab (4) Group Vol. This tab shows the HCP Q1 Unrelated 20 group average T1w volume 
at the same parasagittal slice plane (168) as the individual. 

The group-average volume was generated using FSL’s nonlinear FNIRT volume-based registration, which 
aligns subcortical structures very accurately.  For cortical gray matter, FNIRT registration does not 
invariably respect the topology of the cortical sheet (in contrast to the FreeSurfer surface-based 
registration discussed above). 

• Toggle back and forth between tabs (3) and (4) and note the differences between the two.   

• Go to the Workbench View menu at the top left of your screen (Mac/Linux)/window (PC) and 
select Enter Tile Tabs.  

Now all 4 tabs are showing in a tiled view. This view allows comparison between tabs within the same 
window: here, the individual surface and volume are on the left and the group averaged surface and 
volume are on the right (Figure 1.8).  

The Toolbar and Overlay Toolbox show the controls for the Workbench Window tab you were in when 
you entered Tile Tabs mode. You can switch the controls to a different tab simply by clicking on the tab 

http://www.humanconnectome.org/
http://fsl.fmrib.ox.ac.uk/fsl/fslwiki/FNIRT
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Figure 1.8 – Tile Tabs view comparing individual and 
group average surfaces and volumes 

you want at the top of the Workbench Window—the “pane” in the Viewing Area that corresponds to 
that tab will be indicated by the brief appearance of a white box around it.  

Tiled tab view allows you to interact with the structures in each of the displayed tabs independently. 

• Move your mouse into the upper right 
quadrant, hold your left mouse button 
down and drag to rotate the group 
average surfaces.  

You can zoom, pan, and rotate any of 
the 3D structures separately (these 
functions, except rotation, also work 
for 2D structures, e.g. volume slices 
and flat surfaces). 

• Left click on either of the surfaces and 
note that the volume slices change to 
the parasagittal plane containing the 
identified grayordinate. 

• Use the shortcut Command + M (or 
Control + M in Windows/Linux) to exit 
Tile Tabs View and return to Normal 
View. 

  

http://www.humanconnectome.org/
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Figure 1.9 – BOLD Time-Series on surface and volume slice 

Scene 3: Resting State fMRI Time Series surfaces and volumes 
• In the Scenes Dialog, select “Resting State fMRI Time Series surfaces and volumes” and click 

Show to load the scene. Leave the Scenes Dialog open.  

Note:  If you had inadvertently closed the Scenes Dialog, you can reopen it by clicking the 
clapboard           button in the upper right of the Workbench Window. 

This scene opens with two windows showing the first frame of a resting state fMRI dense time series 
from an individual HCP pilot subject, CP10101.  

The CP10101 resting state time series is displayed on the group averaged inflated left and right 
hemisphere surfaces (in All view) in the Connectome Workbench 1 window.  

Also open is the Connectome Workbench 2 window showing the HCP Q1 Unrelated20 group averaged 
volume with the same CP10101 resting state time series mapped for the subcortical volume voxels in a 
cortical slice and for the surface outline (of the HCP Q1 Unrelated20 group averaged midthickness 
surface).  

Note: Certain recent model Mac 
graphics cards show a blocky 
surface outline with small gaps—
this is something we are working 
to fix. 

In both windows we are currently 
viewing the 10th (time 9 seconds) 
BOLD activation frame of the 
resting state time series. The 
default ROY-BIG palette (Figure 
1.9)—shows high BOLD signal in 
yellow/orange/red and low BOLD 
signals in cyan/green/violet/blue 
(after regressing out the global 
mean signal).  

• Click the up arrow in the frame number field, and watch the BOLD maps change for successive 
time frames.  

• With the cursor in the frame number box, you can hold down the up arrow button on the 
keyboard (or scroll with your mouse scroll wheel) for an animation effect and watch the map 
change over time. 

• Because the data in window 1 is yoked with the data in window 2, both the surface outline and 
the volume voxels will refresh with each new timepoint—pretty cool!  

• Move your cursor to the “C” slice index field (coronal) of the Slice Indices/Coords section of the 
Toolbar in the Connectome Workbench 2 window and scroll or toggle up and down to look at 
the data for a one timepoint as you move through the slice planes. 

http://www.humanconnectome.org/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-DenseTimeSeries
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Scene 4: Functional Connectivity from RS-fMRI surfaces and 
volumes 
**Note: Scene 4 and the subsequent scenes in this tutorial use the HCP Q1 group averaged data 
exclusively. To date (August 2013) HCP has not yet released the extensively processed resting state 
functional connectivity or task data for individuals in Phase 2 as we are still optimizing our pipelines for 
these analyses (but see http://www.humanconnectome.org/data/ for minimally preprocessed image 
and behavioral data from HCP Q1-Q3 participants).  

Viewing Functional Connectivity Data retrieved from ConnectomeDB 
(Correlations with Mean Gray Regression) 
Functional connectivity data is derived from correlations between grayordinates in the resting state 
BOLD data (like viewed in Scene 3: Resting State fMRI Time Series).  Dense connectome files that show 
functional connectivity are REALLY big (~30 GB for current resolution). Because of their size, these files 
are stored in ConnectomeDB, which can tap into these large files as needed to view particular 
connectivity maps of interest.   

This scene is set up for you to learn how access, display, and interact with group averaged functional 
connectivity data from the HCP Q1 Unrelated subjects on the cortical surface and in subcortical volumes.  

• In the Scenes Dialog, select “Functional Connectivity from RS-fMRI…”, and click Show. 

• A Username and Password Dialog will pop up. 

• Enter your ConnectomeDB username and password (same information you used in the 
Workbench data download process). Click OK. 

• Workbench is now accessing ConnectomeDB in order to retrieve functional connectivity data for 
a preselected surface vertex (this may take several seconds). (If you get an error, make sure you 
are connected to the internet). 

The scene opens displaying an inflated surface montage view (Window 1) of group average functional 
connectivity between the vertex on the left hemisphere surface (shown in white) and all other 
grayordinates. In Window 2, a coronal slice is displayed showing functional connectivity with the 
identified vertex in a surface outline and subcortical voxels.  

With this color palette, brain regions that are positively correlated (by Pearson’s r-value that has been 
Fisher transformed) to the identified grayordinate are yellow, orange, and red; those that are negatively 
correlated (after regression of the mean gray-matter timeseries) are displayed in blue, green, and 
indigo.  

The dataset is from 80 scan sessions (20 subjects, 15 min/scan, for a total of 20 hours of scan time).  
Data were averaged across subjects using surface based registration for cerebral cortex and nonlinear 
volume registration for subcortical and cerebellar voxels.  Minimal spatial smoothing (2mm FWHM) was 

http://www.humanconnectome.org/
http://www.humanconnectome.org/data/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-DenseConnectome
https://wiki.humanconnectome.org/display/aWB/Workbench+Glossary#WorkbenchGlossary-ConnectomeDB
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Figure 1.10 – Comparing functional connectivity for three brain locations.  

 

 
Figure 1.11 – Open Remote File Dialog  

done.  Preprocessing and denoising were carried out as described in Glasser et al. 2013, Smith et al., 
2013. 

• Back in Viewing Window 1, click on the left hemisphere surface in the ventral part of the 
precentral gyrus, approximately the same place as the highlighted vertex in Figure 1.10A (white 
arrow, upper left).  

This shows a map of functional connectivity map associated with the face representation in motor 
cortex.  

• Click on the yellow location on the postcentral gyrus (white arrow in Figure 1.10B) to view the 
similar functional connectivity map for the face representation of somatosensory cortex.  

• Now click a green or blue area in the supramarginal gyrus (white arrow in Figure 1.10C). You will 
see a much different connectivity pattern than for either of the previous maps (Figure 1.10C). 
This demonstrates how nearby brain regions can have very different functional connectivity 
from each other in the resting state. 

Comparing functional connectivity maps: full correlation vs. regression of the 
mean gray timecourse 

Now we will load another group average functional connectivity dataset from ConnectomeDB. 

• In the Menu bar, select File►Open Location… (shortcut for Mac: command + L, Linux/PC: 
control + L).  

• A popup will appear as shown in Figure 1.11.  

• Press the Standard radio button. Select “HCP-Q1 Full 
Correlation (Avg 20)” from the pull-down menu under 
“Standard”.  

This dense connectome is from the same dataset 
as the preceding one, except that regression of 
the mean gray timeseries was not carried out.  

• Your Username should be automatically filled in. Type in your Password if you haven’t saved this 
to your preferences. Click OK.  

http://www.humanconnectome.org/
http://www.sciencedirect.com/science/article/pii/S1053811913005053
http://www.sciencedirect.com/science/article/pii/S1053811913005338
http://www.sciencedirect.com/science/article/pii/S1053811913005338
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Figure 1.12 – Alternative representations of functional connectivity maps using an exemplar seed 
in the left supramarginal gyrus (black arrows).  A.  Functional connectivity map after regression of 
the mean gray timecourse (MGT).  B.  Full correlation functional connectivity map for the same seed 
location.  

It will take a few seconds to access the file over the internet. This step makes the selected 30 GB 
dense connectome file accessible, but (fortunately!) does not attempt to load the file. 

As a reminder, the dense connectome data are for demonstration purposes only.  The Q1 Open 
Access Data Use Agreement you agreed to in order to access the tutorial data acknowledges this 
stipulation.  (This restriction is necessary because the advanced methods used to analyze the 
functional connectivity data have not been published or fully vetted).   

• In Overlay Toolbox: Layers, use the second layer’s File dropdown and select CONNECTIVITY 
cifti-average?resource=HCP-Q1:Q1:Demo_HCP_unrelated20_FunctionalConnectivity_FullCorrel   

• In Overlay Toolbox: Layers, turn the second layer On. 

• In the Information box, click on RID to remove any previously selected vertices.  

• Click on a vertex in the left supramarginal gyrus, close to that shown in Figure 1.12A.  

• In Overlay Toolbox: Layers, turn the first layer Off. 

The functional connectivity map should appear similar to that in Figure 1.12B.  Most of the map will 
show positive correlations, but a few locations show negative values, indicating an anti-correlation 
even without regression of the mean gray timeseries (MGT). 

The interpretation of both types of functional connectivity map is complex.  Neither the full 
connectivity map nor the MGT-regressed map represents ‘ground truth’ anatomical connectivity 
(see Smith et al., 2013, Glasser et al. 2013, Van Essen et al., 2013).  Having both available for the 
same datasets should facilitate evaluation of the relative strengths and limitations of each way of 

http://www.humanconnectome.org/
http://www.sciencedirect.com/science/article/pii/S1053811913005338
http://www.sciencedirect.com/science/article/pii/S1053811913005053
http://www.sciencedirect.com/science/article/pii/S1053811913005351
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representing functional connectivity.   Alternative representations, such as partial correlation, can 
also be explored (see Smith et al., 2013).  It is likely that this will remain a topic of ongoing debate 
and discussion in the field.   

 

  

http://www.humanconnectome.org/
http://www.sciencedirect.com/science/article/pii/S1053811913005338
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Figure 1.13 – Group-average map for the Story vs Math task contrast from the HCP Language task.   

 

 

Scene 5: Task fMRI: Language (Story – Math) surfaces and 
volume slices 

• Select “Task fMRI: Language (Story – Math) surfaces and volume slices” in the Scenes Dialog 
box and click Show to load the scene.  

This scene (Figure 1.13) shows the group-average Story vs. Math contrast of the HCP Language 
Processing task, displayed on the inflated surfaces and in subcortical grayordinates on coronal volume 
slices.   

The fMRI data processing included grayordinate-constrained smoothing (4 mm FWHM, respecting 
cortical surface topology and subcortical parcel boundaries).  This has advantages over the volume-
based smoothing that is conventionally applied to fMRI data (see below and Glasser et al. 2013; Barch et 
al. 2013).  Additionally, the averaging across subjects occurs in the grayordinate space, which in which 
the cerebral cortex is better aligned across subjects because of surface-based registration.   

Strong activations are evident in many regions, including anterior temporal cortex, posterior parietal 
cortex, posterior cingulate cortex, and cerebellar cortex. The color bar in the lower left shows a 
maximum z-statistic value of 5.0 and minimum of -5.3.  (In this figure, the color bar spans the +/- 98% 
range of z-values; the actual ranges are higher.  Options for setting z-statistic thresholds, adjusting the 
palette colors, etc. are available using the Layers: Settings: ‘wrench’ icon, as explained in Chapter 2).  

In this task, participants were presented a story task (brief auditory stories, followed by a 2-alternative 
forced-choice question that asks participants about the topic of the story) or a math task (aurally 

http://www.humanconnectome.org/
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Figure 1.14 – Volume slice montage, showing group-
average task contrast for the Story-Math HCP 
working language task generated by a volumetric 
analysis (4mm FWHM volume smoothing).   

 

presented addition and subtraction problems, followed by two choices for the correct arithmetic 
answer, e.g., “twenty-nine or twenty-six”).  

Volume-smoothed contrasts of the Language (Story – Math) task 

• In Window 2: Overlay Toolbox: Layers, toggle the first layer On. 

This layer (Figure 1.14) shows the same Story 
vs. Math contrast of the HCP Language 
Processing task in conventional volume slices. 
For this analysis, smoothing (4 mm FWHM) was 
done in volume space, which increases spatial 
blurring across sulcal banks.  Similarly, cortical 
activations across subjects in volume space 
induces greater blurring.   

Activations are visible in anterior temporal 
cortex, posterior parietal cortex, posterior 
cingulate cortex, and cerebellar cortex, similar 
to those shown in the preceding figure.  The 
peak z-statistic from the volume-average 
analysis is 4.8 (not shown here, but revealed by 
pressing the color bar icon in Overlay Toolbox: 
Layers), which is lower than that from the 
grayordinate-constrained analysis shown above.  
Various advantages of surface-based compared 
to volume-based analysis and visualization are 
discussed elsewhere (Glasser et al. 2013). 

• In Window 2: Overlay Toolbox: Layers, 
toggle the first layer Off. 

Exploring other HCP Task fMRI contrasts  

• In Window 1: Overlay Toolbox: Layers: Map pull-down menu, notice that all the tasks are listed.  

The task data file (TaskFMRI_HCP_Q1_GroupAvg_unrelated20.dscalar) is listed. This file 
contains grayordinate-smoothed group average maps of all the tfMRI contrasts generated from 
the 7 tasks in the HCP protocol.  

Currently, frame 66 with the map name tfMRI_LANGUAGE_STORY-MATH is being viewed. If you 
are having trouble seeing all the text in the File and Map fields, you can expand the Workbench 
Window horizontally and these will enlarge accordingly. You can also click on these fields to see 
the full names of all the Files and Maps loaded. 

http://www.humanconnectome.org/
http://www.sciencedirect.com/science/article/pii/S1053811913005053
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• Toggle the Frame number up and notice the Map name changes as you advance the frame. The 
TaskFMRI… files in Windows 1 and 2 are yoked so that the frames in the windows advance 
together. You can continue to toggle to explore the 86 frames available.  

Specific scenes for each task in the HCP protocol are available in the 
HCP_WB_Tutorial_Beta0.83_part2.scene file included in the tutorial dataset. Detailed instructions 
and descriptions of theses scenes and the contrasts highlighted were created for the WB Tutorial for 
the Q1 data release, which is included as an Appendix to this tutorial.  

  

http://www.humanconnectome.org/
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Figure 1.15 – Surface montage, showing group-average 
myelin map and parcellation borders.  

 

Scene 6: Parcellation Borders display with myelin map 
surfaces 

• Select Scene “Parcellation Borders display with myelin map surfaces” in the Scenes Dialog box 
and click Show to load the scene. 

This scene displays surface borders (contours demarcating boundaries between regions) and shows 
features of the Workbench Features Toolbox. The Features Toolbox currently enables you to display 
loaded borders, foci, and labels. 

The scene opens with a montage of the Q1 unrelated 20 group averaged inflated cortex surfaces 
showing colored cortical areas depicting an architectonic and retinotopic parcellation map published by 
Van Essen, Glasser, Dierker et al. (2011b) (VGD11b). The parcellation map layer is overlaid on the Q1 
unrelated 20 group-average myelin map.  

The Features Toolbox is displayed on the right side of the Workbench Window and borders outlining the 
VGD11b parcels are set to display.  

• Notice the borders that are being displayed match the parcellation map that is displayed as the 
top layer in the Overlay Toolbox. 

• Toggle the Display Borders checkbox off in the Features Toolbox. This will turn off all the 
borders at once. 

• Rotate the surfaces (press the left 
mouse button and drag your 
mouse). As we saw above, red and 
orange represent heavily 
myelinated regions, purple and 
black represent areas of low myelin 
content (Glasser & Van Essen, 
2011).  

• Toggle the Display Borders 
checkbox on and off in the Features 
Toolbox. Notice how many of these 
outlines roughly line up with 
changes in myelin content (changes 
in the map color) that indicate 
borders between cortical areas 
(Figure 1.15). Leave the Borders on.  

As you can see, the borders are useful to mark just the edges of cortical areas when you are viewing 
various types of data on the cortical surface. 

http://www.humanconnectome.org/
http://cercor.oxfordjournals.org/content/early/2011/11/02/cercor.bhr291.long
http://www.jneurosci.org/content/31/32/11597.long
http://www.jneurosci.org/content/31/32/11597.long
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Notice in the Features Toolbox that we are currently in the Borders tab. We’ll discuss the Labels tab 
later in this scene and the Foci tab in the next section. The Fiber tab is currently under development for 
use with diffusion MRI data and is thus greyed out (inaccessible in WB beta v0.83).  

In Borders, under the top level of tabs, there are two tabs for Attributes and Selection. We are currently 
in the Selection tab, which allows you to choose which of the loaded borders you want to display.  

• Move your cursor into the field that lists borders, at the bottom of the Selection tab. 

• Scroll with your mouse wheel or use the up and down arrows of your keyboard to navigate 
through the list.  Left hemisphere borders are listed in the first file tree, right hemisphere 
borders are in the second. 

• Note that the border KPO10 is currently toggled off in both the left hemisphere and right 
hemisphere lists. This was done to highlight area MT in the lateral side of the occipital lobe. 

• Click the checkbox next to border KPO10 in the left hemisphere list. Toggle it on and off. Try this 
again with one or more of the other sets of borders in the list.   

• Click on the grey triangle       next to border KPO10. This reveals the borders that make up this 
border group and allows you to turn them off and on one by one.  Try toggling a few of these 
borders off and on. 

• Above this border list there are two buttons for turning All the listed borders Off or On. Click 
these buttons and note that all the borders listed show checkboxes that match the Off or On 
status.  

• Now click the Attributes tab above. The Borders:Attributes tab contains controls for adjusting 
the coloring, size, and symbol type for the borders displayed.  

• Toggle the contralateral checkbox. This displays the corresponding borders from the 
contralateral hemisphere so that you can compare the differences between the cortical areas 
between hemispheres. 

• Click the contralateral checkbox again to turn it off. 

• Click the Display borders checkbox off again.  

• Toggle the top CIFTI LABELS parcellation layer on again in the Overlay Toolbox. 

In Workbench, label files assign each surface vertex a specific ‘categorical’ name and an associated color 
(or paint). When labels are displayed, regions appear painted on the brain surface. The parcellation map 
in the top layer is made up of many of these labels that describe and color cortical areas.  

• Click the Labels tab at the top right of the Features Toolbox and click on the Selection tab.  

Here you see that the Labels:Selection tab has the same structure as we saw for Borders. 

http://www.humanconnectome.org/
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• Click on the grey triangle       next to Composite Parcellation-lh. As we saw for borders, this 
reveals the labels that make up this label group and allows you to turn them off and on one by 
one.   

• At the bottom of this long list is the red label hOc5_MT for area MT in the occipital lobe. Try 
toggling this label off and on and notice how this label roughly lines up with an orange/yellow 
patch on the myelin map of the Q1 unrelated 20 subjects, indicating high myelin content. 

• Scroll up to the top of the Features Toolbox. Click the Attributes tab.  

• Move your mouse over the Draw as: dropdown and click and select Outline. Look at area MT 
again and see how you can now directly compare the outline of the label for MT and the myelin 
map in much the same way you did when we were looking at borders. 

  

http://www.humanconnectome.org/
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Figure 1.16 – Left midthickness group-average surface 
showing ESM05 foci. Focus AIPS_IP3 is deselected and 
therefore not displayed.  

 

Scene 7: Foci display surfaces 
• Select “Foci display surfaces” in the Scenes Dialog, click Show, and click Close. 

This scene displays identified foci (identified spatial coordinates of interest) that were generated by 
Glasser and Van Essen (2011) using the centers of gravity of the volumetrically analyzed probabilistic 
cytoarchitectonic areas delineated by the Zilles/Amunts group.  Hence, the foci are given "Class Name" = 
ESM05 to reflect the Eickhoff et al. (2005) citation. These areas were used as an important comparison 
to the myelin maps in the Glasser and Van Essen paper. 

The scene opens with the inflated group-average left hemisphere surface showing the identified foci. As 
with Borders and Labels, the Foci tab of the Features Toolbox has Attributes and Selection subtabs. 
Here, we begin in the Attributes tab (if necessary, click on the Attributes subtab). 

• Toggle the Display Foci checkbox to globally turn foci off and on.  

• Toggle the Contralateral checkbox to display foci from the right hemisphere in their 
corresponding locations on the left hemisphere to compare foci positions between 
hemispheres. Toggle it back off. 

• Toggle the Paste to Surface checkbox.  

This option moves displayed foci to the nearest location on the surface being displayed. This is 
useful because identified foci are often slightly above or below the surface because of 
differences in anatomy between subjects, this option brings the foci back to the surface you are 
displaying them on so that you can see all of them clearly.  

• Click on Tab 2 at the top of the 
Workbench Window, showing the 
group average midthickness 
surface.  

• Toggle the Paste to Surface 
checkbox off and on again. This 
feature is especially useful when 
looking at foci in the sulci of 
anatomical surfaces. 

• Click on the Coloring dropdown. 
You can set colors of foci based on 
individual name (the default) or by 
class (here all the foci have the 
same class, ESM05, which is set to 
black).   

In order to edit individual foci name 
colors or class colors in Workbench, you 

http://www.humanconnectome.org/
http://www.jneurosci.org/content/31/32/11597.long
http://www.sciencedirect.com/science/article/pii/S105381190400792X
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must use the Edit Foci function described in Chapter 3: Using Workbench Tools.  

• Move your mouse over and scroll through or select the options in the Draw As and Symbol Size 
dropdowns.  

• Click on the Foci:Selection tab, which allows you to choose which of the loaded foci you want to 
display.  

• In the field that lists foci, click on the grey triangle       next to the foci class ESM05. This reveals 
the foci that make up this foci class and allows you to turn them off and on one by one (Figure 
1.16).   

• Try toggling a few of these foci off and on. 

• Above this focus list there are two buttons for turning All the listed foci Off or On. Click these 
buttons and note that all the foci listed show checkboxes that match the Off or On status.  

• Click on Tab 3 at the top of the Workbench Window. 

This Montage view is displaying the Zilles/Amunts derived foci and the combined architectonic and 
retinotopic parcellation labels that we explored in Scene 6. Some of the identified foci represent the 
center of gravity of the parcels shown. 

The Group setting at the top of the Features Toolbox for Borders, Foci, or Labels allows you to set 
unique features settings (e.g. borders display on, foci displayed as squares, etc.) to be applied 
specifically to different set groups of Workbench Window display tabs. 

 
 

End Of Chapter 1: Exploring HCP Data in Workbench 

Have fun exploring some of the buttons and options we didn’t use in this first taste of Workbench. If you 
want more detail on how everything works, move on to Chapter 2. Check out the Appendix to explore 
more data from the HCP Q1 Unrelated 20 dataset.   

  

http://www.humanconnectome.org/
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Figure 2.1 – File Menu (Open File… and Open Recent Spec File) 

Chapter 2: A Detailed Tour of Workbench  
If you have already completed Chapter 1, you are familiar with some basics, but Workbench has many 
additional features that we will explore below.  

You need not have completed Chapter 1 in order to follow the feature-by-feature descriptions and 
instructions in Chapter 2. In fact, for all the features discussed in Chapter 2 to appear as written, it is 
best to start a new Workbench Session loading the WB beta v0.83 tutorial spec file as described 
below. 

Workbench Splash Screen and Opening a Spec File 
Typically, it is desirable to view many distinct files (surfaces, volumes, and data) concurrently in 
Workbench. To get started, it is convenient to load all such files at once. A Specification File (commonly 
called “Spec File”) is used by Workbench to organize a set of data files to be loaded into the program 
(such as volume, label, and metric files).  

When Workbench is launched, a Splash screen opens (Figure 1.1), containing links to the Human 
Connectome Project (HCP) website and the HCP Twitter account, and showing a list containing a) Spec 
files in the directory path you are currently opening Workbench from, if any, and b) Recently Opened 
Spec Files.  

If you opened the Spec File in Chapter 1, the HCP_beta0.83_tutorial.32k_fs_LR.wb.spec should be listed 
with its path under Recent Spec Files.  

The Splash screen gives you three button options: Open, Open Other…, and Skip. Use the Open button, 
to open a highlighted spec file directly from the Splash Screen:  

• Click on the spec file you want to open in the Recent Spec Files list, and click the Open button. 

Use the Open Other… button to open 
a spec file not listed on the splash 
screen from the Open file dialog 
(Figure 1.2).  

Use the Skip button, to go directly to 
the Workbench Window.  

• From here, you can use the File menu in the Menu bar to open a spec file or any other 
Workbench readable file by selecting File►Open File…  

o Select the desired file and click the Open button. 

o If you wish to re-open a previously opened spec file, select File Menu►Open Recent 
Spec File and choose the file of interest (Figure 2.1). 

http://www.humanconnectome.org/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-SpecFile
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-SplashScreen
http://humanconnectome.org/
http://twitter.com/#!/HumanConnectome
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In all three options, once you have selected and opened the desired file: 
HCP_beta0.83_tutorial.32k_fs_LR.wb.spec, the Open Spec File Dialog will appear (Figure 1.3).  

• The Open Spec File Dialog lists all the files contained in the spec file, organized by file type. The 
tabs in the View File Types: and View Structures: bars at the top of the dialog allow you to view 
a subset of the data files by clicking on a specific file or structure type.  

• Checkboxes on the left indicate which files will be loaded once you press the Load button in the 
lower right. All files are selected by default. Click on the checkboxes to uncheck files that you do 
not want to load. If you want to check or uncheck all the files, click All or None in the Select 
Files: bar near the top of the dialog.   

• The Data Type, Structure, and Data File Name headers can also be clicked to sort the list of files 
by these attributes. 

• The More          gear buttons to the right of each checkbox will, once implemented, allow you to 
select options to set the structure for a file (e.g. Cerebellum, Cortex Left, etc.) or to view any 
metadata associated with the file. If you click on these buttons now, you will see these options 
greyed out indicating that this feature is not yet implemented. 

• Click Load to open the checked files. It may take several seconds or so to load the data files after 
which the Open Spec File Dialog will automatically close. 

• If a scene file is available in the spec file you opened, you can click Load Scenes to load just the 
scene file for now. When you load a particular scene from the Scenes box, the files needed for 
that scene will be loaded into Workbench at that time.  

• If you clicked Load above, proceed to the next section. If you clicked Load Scenes, double click 
the “Tutorial Chapter 2” scene in the Scenes box, and click Close before proceeding. 

Elements of the Workbench Window  
When you load a Spec file, a single Workbench Window (“Connectome Workbench 1”) will open 
containing Viewing tabs. The number and type of tabs that open depends on the structures (brain 
volumes and surfaces) contained in the loaded spec file.  

For the HCP_beta0.83_tutorial.32k_fs_LR.wb.spec file, 5 tabs will open: (1) Montage, (2) Volume, (3) All 
(Whole Brain), (4) Cortex Left, and (5) Cortex Right.  

You can set a Preference to show/not show the Workbench Splash Screen when the program is 
launched. Once you have opened the main Workbench Window, click  
Menu bar►Workbench►Preferences and toggle off Show Splash Screen at Startup. 

http://www.humanconnectome.org/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-Scene
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-WorkbenchWindow
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-ViewingTabs
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           Figure 2.2 – Elements of the Workbench Window 

The Viewing Area defaults upon opening to view tab (1) Montage (the Active Tab) showing the left and 
right cerebral cortex surfaces, lateral and medial views. The top layer of data being shown on the 
surfaces is a map of seven resting state networks from Yeo et al. 2011.  

Components of the Workbench Window are shown in Figure 2.2.  The Overlay Toolbox can be displayed 
in two locations/orientations (see Figure 1.4). On startup, the choice is based on the resolution of your 
monitor (if the vertical resolution is 800 or less, the Overlay Toolbox will be on the left).  

• Selecting View Menu►Overlay Toolbox►Attach to Bottom/Attach to Left allows you to switch 
between the two layouts. 

For the purposes of this tutorial, all 
instructions and figures assume you are 
using the layout shown in Figure 2.2 with 
the Overlay Toolbox attached to the 
bottom of the Viewing Area.  

Workbench allows you to organize and 
view your data using windows and tabs 
analogous to those widely used in web 
browsers. Windows are stand-alone; tabs 
are “pages” within a window. In 
Workbench, all viewing settings of the 
viewed surface or volume in the current 
tab are set in the Toolbar (located at the 
top of the tab) and Overlay Toolbox 
within that tab. 

With the spec file now loaded, let’s take a 
tour of the Workbench Window and 
Viewing Tabs.  

• At the top of the window, you see the 5 tabs of loaded surfaces and volumes. Each tab is given a 
number and title such as (1) Montage.  The title of the Active tab is in bold.  

• Just under the tabs is the Toolbar, which contains basic controls for the structure being viewed 
in the current tab or window. 

• The Overlay Toolbox, at the bottom of the window in Figure 2.2, contains settings for the data 
being viewed on the structure.  

• The Information box, Scenes box, Toolbar, Overlay Toolbox, and Features Toolbox can be 
shown or hidden by clicking the icons in the upper right of the window.  

Information box icon:             Scenes box icon:  

Toolbar icon:             Overlay Toolbox icon:             Features Toolbox icon:  

http://www.humanconnectome.org/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-ViewingArea
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-ActiveTab
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-OverlayToolbox
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-Toolbar
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-OverlayToolbox
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-WorkbenchWindow
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-ViewingTabs
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• To adjust the size of the Workbench Window, click and drag the grab tab in the lower right 
corner of the window.  

• Slowly move the mouse cursor over the Toolbar.  As the mouse cursor stops over a control, a 
yellow/gray highlighted Tooltip pops up describing the function of the control. 

• The Overlay Toolbox and Features Toolbox can be pulled off their docking points in the 
Workbench Window to float any place on your desktop by holding down the left mouse button 
as you drag the top of the Toolbox away from the Viewing Area to the desired location.  As you 
do this, the images in the Viewing Area will resize to fill the Workbench Window. This is one 
convenient way to quickly get a larger view of the structures being displayed. 

Basic Navigation using Mouse Controls 
Several basic surface and volume viewing and navigation functions are controlled with the mouse.   

• In the first Viewing tab labeled (1) Montage, move your mouse into the viewing window 
depicting the brain surfaces. Pressing the left mouse button, move your mouse back and forth 
and up and down to change the orientation of the surfaces.  

• To zoom, press the command key (Mac) or control key (PC, Linux), and move your mouse up 
and down. If you have a mouse wheel, you can also zoom by moving your mouse into the 
Viewing Area and scroll up to zoom out or scroll down to zoom in. 

• To pan (move the brain surface to a different part of the Viewing Area), press the shift key on 
the keyboard, and left click and move your mouse left, right, up, or down.  

• To identify a brainordinate, click on the brain surface. A sphere will appear where you clicked on 
the surface. Also, the Information box should pop up, showing information on the particular 
vertex that was clicked.  

• The color and size of the ID sphere can be adjusted using the Properties button in the 
Information Box (more on the Information box below).   

• By reclicking on the sphere that identifies the brainordinate, you can deselect that brainordinate 
and the sphere will disappear. 

• Click on Tab 2 at the top of the Workbench Window, labeled (2) Volume. Move your mouse 
cursor into the Viewing Area.  

• Zoom on the displayed Volume slice as above, by pressing the command (or control) key and 
moving your mouse up and down, or scrolling up or down with your mouse wheel. 

The default placement of the surface or volume is in the center of the Viewing Area and, in Surface 
View, rotation is about the surface’s center of gravity. Use the Reset button in the Toolbar to 
return to the default zoom, pan, and orientation (see Toolbar below).   
 

http://www.humanconnectome.org/
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                     Figure 2.3 – The Toolbar for Montage, Volume, and All Brain and Surface Views  

• Pan the Volume slice as above by pressing the shift key on the keyboard, and moving your 
mouse left, right, up, or down.  

• Note that the mouse-controlled orientation function activated in Surface or Whole Brain Views 
by pressing the left mouse button and moving your mouse is not active in the Volume View 
mode. All other mouse controls are active in all views. 

• Click anywhere on the Volume slice. As before, the Toolbox Info tab shows information of the 
particular brainordinate that was clicked. 

Toolbar  
The Toolbar (Figure 2.3) contains settings for what brain surface(s) or volume slices you want to view 
from your loaded file (and how you want to view it/them) in the Active Tab. It is organized in sections 
from left to right across the toolbar according to the type of View selected. Tooltips are an easy way to 
find information on the buttons and functions on the Toolbar (or throughout Workbench).   

http://www.humanconnectome.org/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-Tooltip
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• Hover your mouse cursor over one of the Orientation buttons at the top left of the Toolbar. A 
yellow (Mac)/gray (PC/Linux) box of information describing the button your cursor is pointing to 
should popup (a Tooltip). If this doesn’t work right away, make sure your mouse is fully stopped 
over the button.  

• In View, you can set the radio button to Montage, Volume, All, or Surface to view a brain 
surface montage, volume slice(s), any combination of the 3 orthogonal volume planes and all 
the surfaces loaded, or single brain surfaces respectively. When a new type of view is selected 
by clicking a radio button, the toolbar changes to accommodate selections useful to that view 
(compare in Figure 2.3).  

Montage View 

Montage View allows you to simultaneously view lateral and medial views of both left (left column) and 
right (right column) hemisphere surfaces. When the View on the Toolbar is set to Montage (shown in 
the second panel of Figure 2.3), the Toolbar has 6 sections for the type of View, Orientation, Montage 
Selection, Mode, Clipping, and between Window viewing functions. 

• Click back to Tab 1, labeled (1) Montage. 

• Orientation contains buttons to set orthogonal and User-defined views of the brain surface 
displayed. 

o Orthogonal view buttons (right) are labeled: LM (lateral-medial), DV (dorsal-
ventral), AP (anterior-posterior).  

o Move the surfaces by holding down the left mouse button and moving the mouse left or 
right. Click the orthogonal view buttons to see how the view changes. 

o The Reset button reorients the surface, zooming, and panning to the original 
orientation, position, and zoom of the surface (orientation, etc. at file loading). 

o The Custom button allows the user to set and store the current brain orientation, zoom, 
and position being viewed as a particular view of interest.  

 Move, zoom, and/or pan the surfaces into a new orientation by using the mouse 
controls described above.  

 Click the Custom button, and select Create and Edit… 

 The Custom Orientation box (Figure 2.4) appears and shows the values for 
panning, rotation, and zoom for the surface you just reoriented in the active tab 
of Workbench Window 1.  

 Click the New button at the right and type “Test” in View Name field of the New 
Custom View dialog. You can also type notes in the Comment field to help you 
remember details about this orientation (e.g. “from Fig 2 of Van Essen et al. 
2012”).  

http://www.humanconnectome.org/
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Figure 2.4 – Custom Orientation box  

 Move, zoom, or pan the surface away from that orientation. Note that the 
values in the Custom Orientation Box change interactively. 

 Click the Load button and the orientation of the surface will go back to the one 
you set as “Test”. 

 Again, move, zoom, or pan the surface away from that orientation.   

 Click the Copy button and the new orientation will now be saved as “Test”. 
Verify this by again, moving, zooming, or panning the surface away from that 
orientation and clicking the Load button again. 

 Click Close. 

 Again, move, zoom, or pan the surface away from the current orientation.   

 Click the Custom button in the Toolbar again.  

 Select “Test” from the listed Custom view(s) and the orientation will return to 
the modified “Test” orientation.  

• Montage Selection contains pull-downs to set the brain surface you want to view for each 
hemisphere from the list of loaded files. 

o Click on the lower Left Montage Selection pull-down to view the surfaces available for 
the left hemisphere, click on the HCP_PhaseII…midthickness surface to select it.  

o Move your cursor into the Viewing Area. Zoom and turn the surfaces as you would for a 
single surface (hold left mouse button and move mouse). 

The surfaces rotate so that (i) you always have a full view of each hemisphere via the top and 
bottom rows, and (ii) the two hemispheres counter-rotate, so that the top panels show matched 
views (e.g., both frontal or both occipital) and the bottom panels show the opposite views.   

o Translate the surface as you would a single surface (shift + mouse left/right). The upper 
left and lower right panels translate in one direction; the other two panels translate in 

If you do not delete a Custom view you create, it will be available the next time you open Workbench. 
If you create a new view with the same name as a saved view, it will overwrite the original view. 

http://www.humanconnectome.org/
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the opposite direction. This allows you to zoom in on a particular region of interest (e.g., 
the frontal pole) in all panels concurrently. 

o Back in the Toolbar, the second row of Montage Selection pull-downs are used for Dual 
configuration mode. 

o Click on the checkbox to the left of the top row of Montage Selection. 

o Zoom and turn the surfaces to view how the surfaces move similarly in this mode. 

• Mode contains buttons for performing actions including Border drawing (Border), Foci creation 
(Foci) and resetting the mouse controls to viewing mode (View). Mode/tool functions are 
covered further in Chapter 3 in the tutorial. 

• Clipping contains controls for clipping the view in the X, Y, and Z planes. You can set these at a 
specific coordinate plane or set the thickness of the slice of 3-D volume you want to view. The 
checkbox toggles to the left allow you to easily turn the clipping off or on in each plane, once it 
is set. 

• Window contains controls for functions that apply between windows or tabs. 

o Yoking allows the user to define groups of tabs or windows that will have linked 
rotation, panning, and zooming.  Surfaces are yoked so that the corresponding lateral or 
medial contralateral hemispheres can be viewed at the same time (e.g. superior 
temporal gyrus on the lateral surface can be viewed on the right and left hemisphere 
simultaneously). 

Volume View 

• Click on Tab 2 at the top of the Workbench Window, labeled (2) Volume.  

When the View on the Toolbar is set to Volume (shown in the third panel of Figure 2.3), the Toolbar has 
7 sections for the type of View, Slice Plane, Slice Indices/Coordinates, Montage, Mode, Clipping, and 
between Window viewing functions.  

• Slice Plane contains buttons to set the orthogonal volume slice(s) you want to view, whether 
you want to view a single slice, a montage, or oblique angle slices (not yet functional), and a 
reset button. 

o Orthogonal Slice plane buttons are labeled P (parasagittal), C (coronal), 
A (axial, i.e. horizontal) superimposed on simple drawings of the 
appropriate slice view. The All button allows you to look at all three 
orthogonal slice planes simultaneously. 

 Move your mouse cursor into the Toolbar.  Click on the P, C, A, and All buttons 
to see their functions 

o The S (Single Slice), M (Montage), and O (Oblique) buttons set what type of volume view 
you are interested in viewing.   

http://www.humanconnectome.org/
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o Single Slice (S) volume view shows a single parasagittal, coronal, or axial volume slice 
(or all three orientations) at a single set of slice indices, depending on which Orthogonal 
Slice plane button is depressed. 

o The Montage (M) volume view shows a volume montage, a series of volume slices in 
one orientation at regular intervals that are set in the Montage controls in the Volume 
View Toolbar (see below). 

o The Oblique (O) volume view shows a single slice that is rotatable about an oblique axis. 
You can rotate the axis by holding down the left mouse button and moving the mouse 
over the viewing area. The Oblique volume view is not yet functional in Workbench. 

o The Reset button in Slice Plane resets the zooming and panning of the volume slice(s) 
you are viewing. 

 Click on the M button to view a montage of one of the slice planes.  

 Move your mouse into the viewing area and scroll your mouse wheel (or press 
command/control and move your mouse up) to zoom in on the slices.   

 Click the Reset button to return to the default view. 

• Slice Indices/Coordinates contains settings for the slice index and stereotaxic (Talairach) 
coordinate for each orthogonal axis for the currently viewed slice.  

• Montage contains settings for the number of Rows and Columns of slices you would like to view 
when montage volume view is active (activated by clicking the M button, see above). Step 
settings control the size of the gap between slices (in slice index units) that you view in the 
montage.  

The montage slices by default are set to have equal numbers above and below the origin, which 
is typically the anterior commissure (AC), and to approximately span the full extent of the brain. 

o The Origin button in Slice Indices/Coords resets all indices/coordinates to the default 
position centered at the anterior commissure (AC) along the AC-PC (posterior 
commissure) line. 

• Mode, Clipping, and Window Toolbar sections are described above in Montage View.  

All (Whole Brain) View 

• Click on Tab 3 at the top of the Viewing Window, labeled (3) All.  

All (Whole Brain) view allows you to view one or more brain surfaces and volumes in the 3 orthogonal 
slice planes at one time. When the View on the Toolbar is set to All (shown in the lower panel of Figure 
2.3), the Toolbar has 7 sections for the type of View, Orientation, Surface Viewing, Slice 
Indices/Coordinates, Mode, Clipping, and between Window viewing functions.  
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o Orientation is described in Montage View above, except the orthogonal 
view buttons are replaced with L (left perspective) and R (right 
perspective), D (dorsal), V (ventral), A (anterior), and P (posterior) 
superimposed on simple drawings of the appropriate brain view.  

• Surface Viewing allows you to set the type of surfaces and select the structures you want to 
view.  

o Click on the pull-down at the top of the Surface Viewing section. Click and select the 
surface you prefer to view. 

o Uncheck and recheck the checkboxes next to L (left hemisphere), R (right hemisphere), 
and C (cerebellum). 

o Click on the L, R, or C square buttons to set which of the loaded left and right 
hemisphere surfaces you want to view  

o The settings box to the right of the L and R checkboxes controls the separation between 
the left and right hemisphere surfaces.  

The box to the right of the “C” checkbox controls the vertical separation between the 
cerebellum surface and the cerebral cortex surfaces. A cerebellar surface is not included 
in this tutorial but is available in the Conte69 atlas dataset: 
http://sumsdb.wustl.edu/sums/directory.do?id=8291494&dir_name=CONTE69 

o Click the up or down arrows to the right of the settings boxes (or mouse over and scroll 
with the mouse wheel) to move the surfaces relative to each other. 

• Slice Indices/Coordinates Toolbar sections are described above in Volume View. 

• Mode, Clipping, and Window Toolbar sections are described above in Montage View.  

Surface View 

• Click on Tab 4 at the top of the Viewing Window, labeled (4) Cortex Left.  

When the View on the Toolbar is set to Surface (shown in the top panel of Figure 2.3), the Toolbar has 6 
sections for the type of View, Orientation, structure Selection, Mode, Clipping, and between Window 
viewing functions. 

• Orientation is described in All View above, except the L and R orthogonal view 
buttons are replaced with L (lateral) and M (medial) buttons.  

• Selection contains pull-downs to set the brain structure and surface you want to 
view from the list of loaded files. 

o Click on the lower Surface Selection pull-down to view and select the 
249947.L.very_inflated… surface for Cortex Left.  
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Figure 2.5 – Information box  

• Mode, Clipping, and Window Toolbar sections are described above in Montage View.  

Information Box  
The Information box shows you data on brainordinates selected interactively by clicking your mouse on 
a surface or volume.  

• Click back to Tab 1, labeled (1) Montage. 

• Click anywhere on the brain surface in the Viewing Area.  

• Upon making a selection, a sphere will appear where you clicked and the Information box will 
appear (Figure 2.5). 

• Move the Information box wherever you prefer by dragging the top of the box. 

• Information provided for surface ordinates includes the vertex number, surface name, x, y, z 
coordinates on the surface being displayed, and the values for scalars and labels (plus any other 
data that is being displayed) at that ordinate available from files loaded in the current 
Workbench session (Figure 2.5 and Figure 1.5).  

• For volume ordinates, voxel coordinates in stereotactic space and slice indices for the loaded 
volume are given, along with values for connectivity or metric data loaded that displays in 
volumes. 

• Click on RID (Remove Identification) in the right side of the Information box. The identified 
brainordinates will clear on the displayed surface and in the Information box. 

• Click again on the on the brain surface in the Viewing Area. 

• Clicking on the Clear button will clear all text in the Information box. Note this does not clear 
the identification of brainordinates in the Viewing Area. 
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Figure 2.6 – Symbol Properties (left) and Identify 
Brainordinate (right) boxes 

• The Copy button copies all manually highlighted text in the Information box for pasting 
information you want to keep into an external text editor.  

• Click the Contra ID button. 

• Click a few places on one hemisphere of the surface montage. As before, a sphere appears at 
the brainordinate you selected. However, you will see lime spheres have appeared at 
brainordinates contralateral to those you selected (i.e. on the corresponding ordinate in the 
opposite hemisphere).  

• Click on the Properties button. A Symbol Properties box will pop up (Figure 2.6, left).  

• Change the ID symbol color to 
Fuchsia, the ID Contralateral 
Symbol Color to Teal, and the 
Symbol Diameter to 9 and the 
Most Recent ID Symbol 
Diameter to 12.  

• Click OK to enter your changes. 
Notice that the ID symbols 
change on the surfaces. 

• Click again on the Contra ID button to deactivate it. 

• Click on the Select Brainordinate button.  

• An Identify Brainordinate box will pop up (Figure 2.6, right) where for any loaded surface you 
can select a vertex by index number or, if one or more dense connectome CIFTI files are loaded, 
you can select a File and File Row index to identify.  Click Cancel. 

• Click the Close button to close the Information box.  

• Click on the Information box         icon in the upper right corner of the Workbench Window. The 
icon should appear unselected. This means that when you click on a surface or volume to 
identify a brainordinate, the Information box will NOT pop up.  

• Click again on the Information box icon anytime to show the information box.  

Scenes Box 
The Scenes box allows you to save your current Workbench session (loaded files and settings) in a 
file as a “Scene”. Often views in Workbench require several steps to set up. Scenes allow the user to 
save a snapshot of a Workbench session that contains a record of all of the files loaded and view 
settings for that session.  

Even when the Information box is inactivated, information on identified brainordinates is still 
stored and can be seen by showing the Information box (clicking on the icon to reactivate it). 
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Figure 2.7 – Scenes box   

We have provided a scene file in the tutorial dataset with several scenes that offers a quick way to 
load views that show off the HCP data provided and many features of Workbench. By reopening a 
saved scene file, a user can “pick up where they left off” when they reopen Workbench.  

• Open the Scenes box by clicking the clapboard                                   button in the upper right of the 
Workbench Window. 

• The Scenes box (Figure 2.7) will appear.  

• To load a scene, click any of the Scene names in 
the Scenes field to select it and click the Show 
button. (Alternatively, double click on any of the 
Scene names to load it).  

For now, you don’t need to open one of the preset 
tutorial scenes (they are explored scene-by-scene in 
Chapter 1). We will create a new scene in the next 
section (Screen Views).  

• To create a new scene of your current Workbench session to be stored within the current scene 
file, click the Add… button.  

• The New Scene popup will appear in which you need to name your scene and add a description 
of the scene (optional). 

• If you have modified an existing scene and want to save your changes, make sure that the 
correct scene is highlighted and click the Replace… button. 

• To create a new scene file (file that can contain several scenes), click the New… button next to 
the Scene File field. The new scene file you create will have no scenes within it to begin with, so 
you will need to add scenes to it. 

• If you did load one of the other scenes above, double click on the “Tutorial Chapter 2” scene to 
continue with the tutorial. 

• When done, click Close at the bottom of the Scenes box. 

Screen Views and the Window Menu 
In addition to the normal tab-by-tab window-based viewing mode we have been using so far in this 
tutorial, Workbench also has Full Screen and Tile Tabs views.  

• In order to change between views, click on View in the Menu bar at the top of your screen 
(Mac) or at the top of your Workbench Window (PC/Linux). Select Enter Full Screen or use the 
keyboard shortcut Cmd/Ctrl+F.  
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Figure 2.8 – Tile Tabs view 

 
Figure 2.9 – Tile Tabs view without Toolbar and 
floating Overlay Toolbox 

• Full screen view shows your Normal Viewing 
Area without Toolbar or Toolboxes over your 
entire screen. Press Esc or Cmd/Ctrl+F to go 
back to Normal view.  

• Tile Tabs view allows you to view and interact 
with all of the brain surfaces and volumes you 
have open in the tabs of a Workbench 
Window as “panes” in one Viewing Area.  

• Select View►Enter Tile Tabs (or use the 
keyboard shortcut Cmd/Ctrl+M). The views 
for each tab in the active window are tiled in 
order and your view should resemble Figure 
2.8. 

• Click on any of the surfaces. Notice that the 
brainordinate you identified is shown in all 
“panes” of the montage.  

• Rotate one of the surfaces. Each surface/volume rotates, pans, and zooms independently of 
each other unless they are yoked. 

In Tile Tabs view, even though you are viewing multiple tabs at once, the Toolbar and Toolboxes control 
the structures and data for the selected tab only. 

You can switch the controls to a different tab simply by clicking on the tab you want at the top of the 
Workbench Window (or using the shortcuts Cmd/Ctrl+right/left arrow keys)—the “pane” in the Viewing 
Area that corresponds to that tab will be indicated by the brief appearance of a white box around it.  

• Click on Tab (3) All and note the white box indicating your controls have shifted to that tab. 

• Change the top layer to DATASERIES 
CP10101…dtseries.nii.  

• Click the Toolbar icon           to hide 
the Toolbar. 

• Drag the top of the Overlay Toolbox 
to detach it from its anchorpoint at 
the bottom of the Viewing Area.  

• Change the width of the now floating 
Overlay Toolbox by left clicking + 
dragging the resize button on the 
lower right.  

• Click on Tab (2) Volume. 

• Change the top layer to VOLUME 
T1w…nii. Your workspace should now look similar to Figure 2.9.  
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Figure 2.11 – Four “pane” zoomed Tile Tabs 
configuration  

 
Figure 2.10 – Tile Tabs 
Configuration box 

This is a convenient setup for your workspace that maximizes your 
ability to do side-by-side comparisons of different structures and data 
while also allowing you to easily make changes to what you are viewing 
in each tiled tab. 

Using the Tile Tabs configuration option in the View menu, you can also 
control the number and size of the panes in your Tile Tabs view window 
and save these settings. 

• Select View►Tile Tabs Configuration, then select Create and 
Edit…. (shortcut shift+Cmd/Ctrl +M). 

•  The Tile Tabs Configuration box (Figure 2.10) will appear.  

• Click the New button. 

• Type “Tabs 1-4” as the View Name. 

• Set the number of rows to “2” and set the number of columns to “2”. 

The Stretch factors allow you to adjust the relative size of the Tile Tabs “panes”. With 2 rows and 2 
columns, the Index refers to the first (1) and second (2) row and column.   

• Click on the Index 1 Row field and use the toggles, your mouse scroll wheel, or up arrow button 
to set the stretch factor to 2.00. Notice how the first row expands accordingly, while the second 
row shrinks. 

• Click on the Index 1 Column field and also set this stretch factor to 2.00. Notice how the first 
column also expands, while the second column shrinks. Click the Close button. 

• Move the Overlay Toolbox off to the side of the Viewing Area. 

• Move your cursor into the Viewing Area and 
zoom in on each structure until it fills its 
“pane”. Your Viewing Window should now 
look like Figure 2.11. 

In any screen view, you can control the number of 
tabs you are showing by controlling which tabs 
you have open in a particular window using 
options in the Window Menu. As an example, 
let’s move tabs 4 and 5, Cortex Left and Cortex 
Right to a new Window. 

• Click on Tab (4) CortexLeft. 

• Click on the Window Menu at the top of your 
Desktop or Workbench Window. 
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Figure 2.12 –Tile Windows view  

• Select Move Selected Tab to 
Window►New Window. A second 
Workbench Window will appear 
with Tab (4) in it. Notice that Tab (5) 
replaced Tab (4) in the Tile Tabs 
configuration of Window 1.  

• Click on Tab (5) CortexRight. 

• Similarly move this tab to the 
Connectome Workbench Window 
2 that you just created. Now Tabs 
(4) and (5) are in a window together 
in the normal screen view.  

• Click anywhere on this new Workbench Window 2 to select it. Now that it is selected, use the 
shortcut Cmd/Ctrl +M to invoke Tile Tab view for this window.  

• Click on the Window Menu again and select Tile Windows. This will resize both windows to fill 
your Desktop as in Figure 2.12.  

• Resize the windows, and move or turn on/off the Overlay Toolbox and Toolbar as desired.  

Once you find a workspace configuration and particular view for a set of data that you like, you can 
save a scene with those settings so that you can easily come back to that view of the data.   

• Open the Scenes box by clicking the clapboard       button in the upper right of the Workbench 
Window. 

• Click Add and name the scene as desired, e.g. “My Tutorial Screen View”.  

• Click OK. You should see you new scene added to the scenes list.  

• Double click on any of the other scenes listed to load them.  

• Double click on the scene you just created and notice that all your settings were saved. 

• Double click on the “Tutorial Chapter 2” scene to continue with the tutorial. 

Overlay Toolbox  
The Overlay Toolbox, located below the Viewing Area, contains settings for what loaded data you want 
to view on the brain structure you are viewing in the currently Active Tab. When you change a setting in 
the Overlay Toolbox, the changes only apply to the tab you are currently viewing. The Overlay Toolbox 
is organized in tabbed menus: Layers, Connectivity, Data Series, and Vol/Surf Outline. 

• Click back to Tab 1 labeled (1) Montage at the top of the Viewing Window. 

• Click on the Overlay Toolbox Layers Tab.  
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Figure 2.13 – Overlay Toolbox: Layers Tab  

 
Figure 2.14 – Overlay Toolbox: Layers Tab, Map Selection 

Layers Tab 
The Layers Tab (Figure 2.13) allows you to set the files and maps you want to visualize on the brain 
surface or volume currently displayed in the Viewing Area of the Active Workbench Window Tab.  

The layers set in the Layers Tab apply to all surface types of the structure displayed in the Viewing Area 
(e.g. if you set layers for an Anatomical surface then switch to an Inflated surface, the layers will remain 
the same).  

By default, Workbench loads 3 layers into the Toolbox. The top layer of displayed data is listed first, the 
second layer below that, etc., like a layer cake. 

• Click to check and uncheck the checkboxes under On at the left side of the Layers Tab. The data 
loaded into each layer will be toggled off and on on the displayed surface. When a top layer is 
unchecked, you see the layers underneath that layer displayed on the surface.  Leave all 3 layers 
unchecked.   

• In the File pull-down you can set what file you want to view from the data files that loaded 
when you opened your spec file. Each file contains one or more brain maps that can be 
displayed on the surface.  

• Check the top layer On and set File to: 

CIFTI LABELS parcellations_VGD11b.L.32k_fs_LR.dlabel.nii 

• Click the Map pull-down button in the top layer, select Brodmann lh (Figure 2.14).  

The top layer will now display the classical Brodmann (1905) architectonic parcellation.  This 
map is derived from a mapping of the Brodmann areas onto the colin.R and colin.L atlas 
subsequently registered (deformed) to the fs_LR atlas.  

• Uncheck the ‘On’ checkbox at the left of the top layer.  
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Figure 2.15– Layers Settings: Non-Thresholded Data 
  

• Check On the second layer and you should now see  
CIFTI SCALARS HCP_PhaseII_Q1_Unrelated20.MyelinMap_BC. 32k_fs_LR.dscalar.nii 

• Also check On the third layer and set File to 
CIFTI SCALARS HCP_PhaseII_Q1_Unrelated20.sulc.32k_fs_LR.dscalar.nii  

• Click the Settings          button in the second layer, to the right of the checkbox.  
• A popup window will appear, as seen in Figure 2.15. If you’d like to reposition this box, left click 

and drag the top of the popup to the desired position on your screen. 

• The Overlay and Map Settings box allows you to set attributes of the map selected for the layer 
for which the settings button was clicked. Currently, there are five tabs in this box: Labels, Layer, 
Metadata, Palette, and Trajectory. 

• The Labels, Metadata, and Trajectory tabs are currently under development. The Labels tab will 
allow you to edit the color and name of map labels; the Metadata tab will allow you to add 
descriptive metadata to a map; the Trajectory tab will allow you to set properties for display of 
a Fiber Trajectory file.   

• The Layer settings tab is currently only active (not greyed out) for Volume layers in the All 
(whole brain) view. Here, you can set whether voxels are drawn on the slices or as 3D cubes 
(only applies in the All viewing mode). 

• Click on the Palette tab, if not already selected. Here, you can change the thresholds applied to 
the map being viewed, change the color palette (spectrum) of the displayed data, and view a 
histogram of the data being mapped.  

• Click on the Type pull-down in the Threshold section of the Palette tab. Select On.  
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Figure 2.16 – Layers Settings: Thresholded Data  

• Move the High and Low sliders to adjust the high and low thresholds. The default is to show 
Data Outside the Thresholds. Select the Show Data Inside Thresholds radio button. In both 
cases, data excluded by the thresholds is shaded blue in the histogram graph.   

• Again move the High and Low sliders to adjust the thresholds. The display in the Viewing Area 
should look something like Figure 2.16.  

• To change the palette, or color spectrum, of the data displayed on the surface, hover over the 
palette selector below the Threshold settings and scroll to browse the different palettes  
available (or left click and select from the pull-down). Reset to the original videen_style palette. 

• The Range pull-down menu allows you to set the range of data controlled by the Threshold 
sliders by range of data values in the File or Map or by Unlimited values. 

• The settings below the Palette selector allow you to set the range of data you want represented 
in the palette. Selecting: 

o Full shows the full range of the data. 

o Percent shows the range of data set by percentage in the settings below it (here the 
spectrum positive maximum is set to 96% and the positive minimum is set to 4%, 
therefore the top and bottom 4% of data values are not represented in the spectrum).  

o Fixed shows a range of data in real data values set by the user (for this myelin map data, 
a positive max of 1.6 and a positive min of 1.1 makes sense).     

• Set the Palette selector pull-down back to videen_style, set the Threshold Type pull-down back 
to Off, and close the Overlay and Map Settings popup by clicking the red X button in the top 
left or right, or the Close button in the bottom right.  
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Figure 2.17 – Setting Layer Opacity 

• Back in the Layers Tab, the Colorbar             button shows a colorbar of the data spectrum set in 
the Settings Box. If thresholds are set, the colorbar will reflect the high and low thresholds.  

• The Add/Move/Remove Layer            button opens a dropdown with options to add new layers, 
move layers up and down, and remove layers. 

• The toggle box to the right of the layer add/move button allows you to set the Opacity for the 
layer.  

• Use the down arrow to set the Opacity of the CIFTI SCALARS 
HCP_PhaseII_Q1_Unrelated20.MyelinMap… layer to 0.40. The Viewing Area should look like 
that of Figure 2.17. Notice the Tooltip for opacity in the yellow box on Figure 2.17.  

• Click on the top layer’s File dropdown and 
select DATA_SERIES CP10101_HCP_Pilot-
1.fMRI.dtseries.nii.  

• Click the On checkbox for the first layer. 

• You are now viewing the first (time 0 seconds) 
BOLD activation frame of the resting state 
time series. The default ROY-BIG palette (as in 
Figure 1.9)—shows high BOLD signal in 
yellow/orange/red and low BOLD signals in 
cyan/green/violet/blue (after regressing at 
the global mean signal).  

• In the frame number field, click the up arrow 
(or mouse scroll up) and watch the BOLD 
maps change for successive time frames.  

• The Yoke option allows you set a yoke group (identified by Roman numerals in the Yoke pull-
down) to link viewing the maps of more than one data series file by “frame” to ease display. This 
is especially useful for viewing and comparing two files containing the same type of data for (e.g. 
comparing the same task activation between two or more subjects over various experimental 
conditions, or comparing two or more types of processing for data from the same subject). 
Yoking groups are active between Workbench Windows and Tabs. 

Connectivity Tab  

The Overlay Toolbox Connectivity Tab lists connectivity files that are loaded in your Workbench session. 
The Connectivity Tab is greyed out (inactive) if no connectivity files are loaded, as we have here in 
chapter 2.  In chapter 1 of this tutorial, when we access the dense functional connectivity via the Open 
Remote File dialog as described in Scene 4: Functional Connectivity from RS-fMRI surfaces and volumes, 
the links to the functional connectivity data appear in the Connectivity Tab (Figure 2.18).  
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Figure 2.18 – Overlay Toolbox: Connectivity Tab 

 
The checkboxes to the left of the listed connectivity files control whether the connectivity is refreshed 
when you identify a brainordinate. Turning these off can be important when many connectivity files are 
loaded or when your internet connection to remote files is slow or disabled.  

Charting Tab  

The Overlay Toolbox Charting tab lists all dense scalar and dense data series files that contain multiple 
maps currently loaded into your Workbench session.  Both of these file types contain continuous (real 
numbers) for some or all brainordinates (cortical hemisphere vertices and/or sub-cortical voxels).   

A dense data series file contains a sequence of related data with one measurement for the 
brainordinates in each of many maps (frames) and each map (frame) is in the same data units.  The 
names of the map in a data series file indicate the position within the sequence of the data.  The most 
common data series file we use for HCP is the time series file (commonly resting state data) and its map 
names are the time corresponding to frame in the MRI data.  Other non-temporal data sequences may 
be added in the future.   

In contrast, a dense scalar file contains one or more maps of related or non-related data and the data in 
each map may be of different units.  The names of the maps in a dense scalar file are text describing the 
data within the map.  Examples of dense scalar files include myelin data, rfMRI/tfMRI contrast maps, ICA 
components, or cortical shape data.   

Both files types have their data colored by a color palette and the user may adjust the settings that are 
used to apply the color palette.  Since a dense data-series file contains multiple frames of related data, 
there is a single color palette within the data series file that is used to color all frames within the file.  In 
contrast, since dense scalar files usually contain unrelated data, each map in the dense scalar file 
contains a color map so that the data within each map may be uniquely colored.  Lastly, all maps within 
a single data series or scalar file must always contain the same number of brainordinates. 
 

Comparison of File Attributes 
Attribute Dense Data Series Dense Scalar 
Maps/Frames Sequence of Related           Unrelated 
Palette Mapping     One per file                         One per map 
Maps       Many Frames                         Smaller number of maps  
Units All Frames same units         Each map may be different 

units 
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Figure 2.20 – Data Series Time Course Graph 

 
Figure 2.19 – Overlay Toolbox: Charting Tab 

 

• Click on the Overlay Toolbox: Charting tab. 

• When the HCP_beta0.83_tutorial.32k_fs_LR.wb.spec Spec file was loaded, three dense data 
series files were loaded and are listed in the Charting tab (Figure 2.19).  

The first file contains grayordinate-smoothed HCP Q1 group average task fMRI contrast maps. The 
second contains a single frame grayordinate-smoothed myelin map. The third file contains volume-
smoothed HCP Q1 group average task fMRI contrast maps with the same number/types of contrasts 
as the first file. The last file is the BOLD fMRI dense time series file from the individual subject 
CP10101.  

• The Graph button           for each row activates the time course graph function for the data series 
file listed. When a grayordinate is identified, a popup box appears that shows variation of the 
activity signal over the time course. This is especially useful for analysis of resting-state fMRI 
BOLD signals in different brain regions. 

• Click the graph button for the bottom 
CP10101… file.   

• Click anywhere on the brain surface. 
A Time Course graph will pop up 
(Figure 2.20).  

• Click again on the surface. The time 
course for that grayordinate is shown 
in a different color along with the first 
on the graph. 

• Move your mouse over the graph and 
scroll up and down to zoom along the 
X axis. Alternatively, adjust the high 
and low Time fields at the top left of 
the Data Controls to adjust the time 
range of data you want to view (X 
axis). 

• Click the Zoom Y Axis checkbox (and deselect the Zoom X Axis checkbox) to enable Y axis 
zooming with your scroll wheel in the graph area. Alternatively, adjust the high and low Activity 
fields in the Data Controls to adjust the activity range of data you want to view (Y-axis). 
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• Click Reset View to reset the zoom to the defaults defined by the data. 

• Click the Show Average checkbox to show an average of the two (or more) time courses viewed 
on the graph. 

• The History section allows you to interactively set the number of time course plots you want to 
keep on the graph before they are overwritten and shows X, Y, Z coordinate values of the 
grayordinates you clicked color-coded to match their displayed time course plots. 

• The Open... button allows you to open a timeseries Dvars .txt file for viewing as a chart. 

• The Export… button allows you to save an image of the graph currently displayed or save the 
data for a particular plot as a .txt file.  

o To save the graph currently displayed, click Export…  

o Choose a file name with the image file type extension (e.g. .jpg) you want (default is 
.bmp), make sure that Image files is chosen as the file type, and click Save.  

o To save the data from a particular plot (one column of data from the CIFTI dscalar or 
dtseries file), first select the desired plot by clicking on the corresponding coordinate in 
the History section (e.g. CortexRight:[51.9723, -71.6251, 6.31683]), then click Export…  

o Choose a file name, change the file type to Dvars files (*.txt), and click Save.  

•  Click Close to close the Time Course Graph window.  

• Back in in the Charting tab, click the pressed down (darkened) Graph button        again to turn 
off the Time Course Graph popup. 

Volume/Surface Outline Tab 
The Overlay Toolbox Volume Surface Outline Tab (Vol/Surf Outline for short) allows you to set 
parameters for viewing brain surface outlines on volume slices in the Volume or All (Whole Brain) 
Viewing Tabs (the Vol/Surf Outline tab is inactive in the Surface and Montage Views). This is useful for 
comparing your Freesurfer or otherwise reconstructed surface with your T1-weighted structural maps as 
a check of the quality of the surface. It is also useful for viewing Connectivity data (dense connectivity 
and BOLD dense data series files) on both the cortical ribbon and in subcortical voxels (see Scene 3: 
Resting State fMRI Time Series surfaces and volumes in Chapter 1). 

• Click on Viewing Tab 2, (2) Volume. 

• Click on the Overlay Toolbox: Layers tab and switch the first layer to VOLUME 
T1w_restore.nii.gz (individual subject 249927). 

• Click on the Overlay Toolbox: Vol/Surf Outline tab.  

http://www.humanconnectome.org/
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Figure 2.21 – Overlay Toolbox: Vol/Surf Outline Tab 

 
Figure 2.22 – Volume Surface Outline: 
Top layer of Viewing Tab 1 

 
Figure 2.23 – Volume Surface Outline: 
White and Pial surfaces 

• Click the top two outline selections On, change the Color Source for both to Tab 1, the 
Thickness to 2.00 and the Files to the individual left and right midthickness surfaces 
(249947.L.midthickness.32k_fs_LR.surf.gii and 249947.R.midthickness.32k_fs_LR.surf.gii) as 
shown in Figure 2.21. 

• We are now viewing the surface outline for the individual time-series BOLD activation for 
CP10101 (which is the top layer for Tab1 montage) for both hemispheres (Figure 2.22). 

• Click the up and down arrows in the Thickness column to adjust the thickness of each outline. 
The default thickness of 5.00 is approximately the width of the cortical gray matter ribbon. 
Thickness is centered at the average cortical midthickness.  

• Toggle off these first two surface outlines and toggle on the third, fourth, fifth, and sixth 
outlines. 

The third and fourth outlines show the white matter/ gray matter boundary surface for this 
individual in lime green. The fifth and sixth show the pial surface in blue. 

• In the Toolbar, scroll or toggle through the Axial (A) slice indices and watch the outline change 
with the volume (Figure 2.23).  

http://www.humanconnectome.org/
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Figure 2.24 – Borders Selection  

Features Toolbox 
The Features Toolbox allows viewing of additional features such as borders and foci on top of data 
layers set in the Overlay Toolbox.  

• Click on Viewing Tab 1, (1) Montage. 

• Click off the top layer to display layer 2, the group average Myelin Map. 

• To open the Features Toolbox, click the Features Toolbox icon           in the upper right corner of 
the Toolbar. 

o Alternatively, in the Menu bar, select View►Features Toolbox►Attach to Right.  

• To detach it from the right side of the Viewing Area, place your cursor on the top of the 
Features Toolbox hold down the left mouse button and drag the Toolbox to the side off the 
Workbench Window. This will also restore the full size of the Viewing Area. 

• The Group dropdown allows you to set the Features group for your current Active Viewing Tab.  

• Grouping tabs allows you to change the Features that you are displaying in several Viewing Tabs 
all at once. For example, you may want to display a particular set of borders in tabs 2, 3, and 5 
only (Group A) and another set of borders and foci in tabs 1 and 6 (Group B).  

• When the Group dropdown is set to ‘Tab’, the settings in the Features Toolbox will apply only to 
the Active Tab.  

Borders Tab 
The Borders Tab in the Features Toolbox allows you to display and view an organized selection list 
of loaded and newly created borders on brain surfaces.  

Note: Currently, borders are only viewable on surface structures. 
Future versions of Workbench will enable this feature in brain 
volumes as well.  

• Toggle on Display Borders in the Borders: Attributes tab.  

• Click on the Borders: Selection tab.  We are viewing the 
borders from the parcellations_VGD11b...border file for each 
hemisphere (recall VGD11b is from the Van Essen et al. 2011b 
publication). 

• Loaded borders are organized by border file (top tier) and 
class (second tier) (Figure 2.24).  

These borders are derived from a composite cortical 
parcellation based on architectonic or retinotopic fMRI 
maps (Van Essen et al. 2011b). Border class abbreviations 
(FRB08, OFP03, etc.) refer to the publication that defined 

http://www.humanconnectome.org/
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Figure 2.25 – Foci Attributes 

a particular cortical area in the map (cf. Table 3 of Van Essen et al. 2011b). 

• If they are not displayed already, in the Layers tab of the Overlay Toolbox, change the top layer 
to:  

CIFTI LABELS parcellations_VGD11b.L.32k_fs_LR.dlabel.nii     

• The borders match the Composite Parcellation map from the Labels file. 

• Click off the second layer in order to see these parcellations more clearly. 

• Zoom and pan to get a close up view of some of the borders on the surface. 

• Click back on the Borders: Attributes tab.  

• Toggle on and off the Contralateral checkbox. This button displays the borders of the 
contralateral hemisphere on top of the borders from the hemisphere you are viewing. Notice 
the differences in the parcellation borders between the two hemispheres.  

• Toggle off Display Borders and Reset the orientation. 

Foci Tab 
The Foci Tab in the Features Toolbox allows you to display and view an organized selection list of loaded 
foci on brain surfaces. 

Note: Currently, foci are only viewable on surface structures. Future versions of Workbench will 
enable this feature in brain volumes as well.  

• In the Features Toolbox, switch to the Foci: Attributes tab 
(Figure 2.25)  

• Toggle on Display Foci, change the Size to 8.0.  

• The default shape of foci is Squares to differentiate foci from 
identified brainordinates. Change Draw As to Spheres. 

• Change the Coloring to Class, now all the foci should be 
displayed in black since all are in the same class. 

• Switch to the Foci: Selection tab.  

Just as with the borders, loaded foci are organized by foci 
file (top tier) and by class (second tier).  

• Foci from the Parcels_GV11...foci file are located at the center 
of mass of the probabilistic cytoarchitectonic areas (originally defined by Amunts and Zilles) 
used by Glasser and Van Essen 2011 for comparison to areas defined by myelin mapping.  

• Toggle off Display Foci. 

• Click On the second layer (Myelin Map) in the Overlay Toolbox: Layers tab. 

http://www.humanconnectome.org/
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Figure 2.26 – Label Selection  

Labels Tab  
The Labels Tab in the Features Toolbox allows you to display and view an organized selection list of 
loaded labels (named colored regions) on brain surfaces. Therefore, when labels are displayed, regions 
appear painted on the brain surface. The parcellation map (parcellations_VGD11b) in the top layer is 
made up of many of these labels that describe and color cortical areas.  

Note: Currently, labels are only viewable on surface structures. Future versions of Workbench will 
enable this feature in brain volumes as well.  

• In the Features Toolbox, switch to the Labels: Selection tab (Figure 2.26).  

Here you see that the Labels:Selection tab has the same 
structure as we saw for Borders. 

• Click on the grey triangle       next to Composite Parcellation-
lh. As we saw for borders, this reveals the labels that make 
up this label group and allows you to turn them off and on 
one by one.   

• At the bottom of this list is the red label hOc5_MT for area 
MT in the occipital lobe on the left hemisphere. Try toggling 
this label off and on and notice how this label roughly lines 
up with an orange/yellow patch on the myelin map of the 
HCP_Q1_Unrelated subjects, indicating high myelin content. 

• Scroll up and click the Attributes tab.  

• Click the Draw as: dropdown and select Outline. Now only 
the edge of the label is shown as a colored outline. 

• Switch back to Selection tab and click All: Off 

• Click the ‘X’ in the top left corner of the Features Toolbox to close it.  

Save/Manage Files 
The Save/Manage Files dialog allows you perform several operations on the files loaded into your 
Workbench session, including saving modified files. 

• Select File Menu►Save/Manage Files… (or the shortcut: command + S) to open the dialog 
(Figure 2.27).  

The bars at the top of the dialog contain buttons that filter the listed files as we saw in the Open Spec 
File dialog (Figure 1.3).  

• Checkboxes in the Save column the left allow you to choose which files will be 
saved/overwritten once you press the Close button in the lower right.  

http://www.humanconnectome.org/
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Figure 2.27 – The Save/Manage Files dialog   

 
Figure 2.28 – Help menu   

• A YES in the Modified column 
indicates that there have been 
changes to the listed file that 
need to be saved or discarded. 

• The checkboxes in the In Spec 
column indicate whether the file 
is currently being saved as part of 
the Specification file shown at the 
top of the list. You can use these 
to add or take files out of a spec 
file.  

• Click on a few of these In Spec 
checkboxes and notice that a YES 
appears in the Modified column 
for the Specification file because 
you have indicated that you want 
to remove files from the spec file. 

• If you wanted to saved these changes, you would need to click the Save checkbox for the spec 
file and click the Save Checked Files button at the bottom right. 

• The Read column allows you to: 

o reload files that are currently loaded into memory (indicated by     )  

o load files that are currently not loaded (indicated by     ) 

• The Remove column removes a previously loaded file from memory but not from the spec 
file itself.  This is useful if you are running other applications that are memory intensive. 

• The More column       gear buttons allow you to edit the metadata associated with a file or 
change the name of a file. If you edit the metadata, you will see that that is sufficient to trigger 
the YES in the Modified column.  

• Remember, if you want to save the changes to any file you modified here or elsewhere in 
Workbench, you need to click the Save checkbox for the file, and click the Save Checked Files 
button (or hit Return).  

Help Menu 
The Help menu (File Menu►Help…) (Figure 2.28) 
gives you options to search Workbench, launch the 
HCP website and Submit feature requests to the 
developers of Workbench software. 

http://www.humanconnectome.org/
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Figure 3.1 –ID of heavily myelinated MT patch 

Chapter 3: Using Workbench Tools  

Border Mode  
Workbench not only allows the user to show existing borders on surfaces, but also has a tool to draw 
new borders. Here, we demonstrate how to draw and edit a new border that encloses an exemplar 
Region of Interest (ROI), a heavily myelinated patch from a CIFTI SCALARS file, then show how to display 
the average Connectivity data for that ROI. 

Drawing Borders 
• In Workbench Window Tab 4 Cortex Left, set the left cortex Surface to 

HCP_PhaseII_Q1_Unrelated20.L.very_inflated.32k_fs_LR.surf.gii. 

• In the Overlay Toolbox, set the first layer to CIFTI SCALARS HCP_PhaseII_Q1_Unrelated20. 
MyelinMap_BC... as in Figure 3.1. 

• In the Menu bar, select File►Open Location… (shortcut for Mac: command + L, Linux/PC: 
control + L).  

• The Open Location popup will appear as shown in Figure 1.11.  

• Enter your ConnectomeDB username and password (same information you used in the 
Workbench download process). Click OK. 

• Click Standard radio button.  Press OK. 

• Set the second layer to CONNECTIVITY…FunctionalConnectivity_mgt-regression so that the 
Dense Connectivity data will be accessible after drawing the border. 

• Click on the myelinated patch on the lateral side of the occipital lobe as shown in Figure 3.1.  
The Information box will pop up and show the information for that location.  In the line the 
starts with CIFTI LABELS parcellations…, you can see this area is identified as area MT. 

• Zoom and pan the surface 
to focus on the MT area 
you identified. 

• To increase the size of the 
viewing area, turn off the 
Overlay Toolbox by 
clicking the ‘X’ button in 
the upper left hand 
corner or deselecting the 
Overlay Toolbox icon  in 
the upper right hand 
corner of the Workbench 
Window.   

http://www.humanconnectome.org/
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• Click the Border button in the Toolbar: Mode section.  This opens the Border drawing and 
editing tools at the top of the Viewing Area. 

• The loaded border files are automatically displayed on the surface.  To turn them off before 
drawing a new border, click the Features Toolbox icon          in the upper right hand corner of 
the Workbench Window to pop up the Features Toolbox on the right edge of the Viewing Area.   

• Click the Borders:Selection tab. 

• Click the down arrow beside the border files (parcellations_VGD….) to collapse the list of borders 
and deselect their checkboxes.  This will turn off every border within that file. 

• When you start Border Mode, the Draw tools are selected by default (at the top of the Viewing 
Area) and the cursor becomes a pen icon, indicating that you are ready to draw a border. 

• Now use the myelin map as your guide to draw an outline around the MT patch.  While holding 
down the alt/option key and the left mouse button, trace around the entire green and yellow 
patch that is identified as MT with your mouse in a clockwise direction.   

o You can draw multiple short sections (these just all need to be drawn in the same 
direction) in order to make a complete border or you can draw a single, continuous 
line.   

o Reminders of the mouse and key strokes used to draw a new border, or erase, extend, 
or replace a border you have already drawn are available as Tooltips. Hover your 
mouse over the New, Erase, Extend, or Replace buttons for the tooltips to appear.   

o The mouse controls for rotating, panning and zooming a structure in the Viewing Area 
are still active in Border mode. 

• When you have completed drawing the border, click the 
Finish button.  A popup box will appear (Figure 3.2). 

o You can either add the new border to an 
existing Border File or you can create a new 
border file.  Since we drew the border 
around an ROI in order to get average 
connectivity for that region (in a upcoming 
step), we will create a new border file.   

o Click on the Border File New button, enter the name “ROI-for-avg-
connectivity.border”, and Click Save. 

o Click Name Add/Edit button to create a name for the new border.  In the popup, 
click New and enter “Test-myelin-patch” in the Name: field.  

o Select a color for your border with the scroll bars (choose Blue = 255 for tutorial 
purposes). 

o Click on the Class Add/Edit button.  Select New and enter the Name “Myelin”.  
Select a color with the scroll bars (Green = 255) and click OK. 

o Select the Closed Border checkbox, since this is a fully closed border. 

 
Figure 3.2 – Finish Border popup box 

http://www.humanconnectome.org/
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Figure 3.4 – Average Connectivity for area within border 
‘Test-myelin-patch’  

 
Figure 3.3 – Selecting Connectivity Averaging for a newly 
created ROI   

o Press OK. 

o Your new border will turn blue on the surface and the new border file and class will 
show up in the Features Toolbox. The start point and end point of the border are 
marked as green point on the border for reference. 

Viewing Average Connectivity of a border encompassed region 
• RIGHT click on the border you just 

drew.  A popup will give you a few 
options (Figure 3.3).   

• Click on ‘Show CIFTI Connectivity 
for Nodes Inside Border Test-
myelin-patch’.  

The calculation for viewing the 
average connectivity for this 
ROI will take a few moments.  

• Click the           icon in the right top 
corner to turn the Overlay Toolbox 
back on.  

• Deselect the top CIFTI SCALARS 
layer in order to show the 
CONNECTIVITY layer underneath. 
You are now viewing the Average 
Connectivity for the 
brainordinates within the area of 
Test-myelin-patch (Figure 3.4). 

Editing Borders 
Once you have drawn a border you can 
adjust/correct just a portion of a border 
that you otherwise are happy with while 
still in Draw mode .   

Editing Closed Borders 
We will start by editing the closed border 
we just created, erasing and redrawing a 
section. 

• Pan and zoom to focus on the 
Test-myelin-patch border we created above. 

http://www.humanconnectome.org/
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• Click the Erase button. Then click the mouse twice, once at the beginning of the section that is to 
be removed and once at the end of the section. Then click the Finish button. The section of 
border that you clicked on either side of will disappear (Figure 3.5A,B). 

• Click the Replace button. While holding down the alt/option key and the left mouse button, draw 
a new section in the same direction as the border you are replacing was drawn (clockwise). Your 
trace will appear in red (Figure 3.5C). If you make a mistake, hit Reset and redraw. 

• When you are satisfied with your replaced border section, hit Finish and the completed edited 
border will be shown in a single color (Figure 3.5D).  

Editing Open Borders 
Now, we will draw a non-encompassing, or open, border defining the boundary between Brodmann 
area 44 and area 6 (Figure 3.6). 

In Overlay Toolbox: Layers, set the top layer to CIFTI LABELS 
parcellations_VGD11b.L.32k_fs_LR.dlabel.nii and change the Map to Brodmann lh. Turn the second 
(connectivity) layer off.  

• Zoom and pan the surface to have 
Brodmann areas 44 and 6 in the center of 
the viewing area (purple and dark fuchsia 
regions on the surface). 

• While holding down the alt/option key 
and the left mouse button draw a border 
between these two areas in the ventral to 
dorsal direction. Click the Finish button.   

• In the Finish Border popup (Figure 3.6): 

o Click the New button for Border 
File and enter the new name of 
“Boundries.border“ and click 
Save. 

o Click the Add/Edit button next to 
Name.  

 
Figure 3.6 – Drawing/finishing the Brodmann 44/6 
Boundary border 

 
Figure 3.5 – Erasing and replacing a section of the closed border ‘Test-myelin-patch’.  
A) Points selected (red) defining section of the border to be erased, B) Erased section, C) Replacement 
section is drawn, D) Edited border.  

http://www.humanconnectome.org/
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 In the Edit Name attributes popup click New and enter “Brodmann 44/6 Boundary” 
in the Name field.  

 Use the scroll bars to select a color, we’ll use light blue here.  

o Similarly click the Add/Edit button next to Class, and the New button in the Edit Class 
Attributes popup and enter a new Name of “Boundaries”, keep the default color of 
black, hit OK. 

o Deselect the Closed Border checkbox. 

o Click OK. 

• In the Features Toolbox, click on the Borders: Attributes Tab and in the Coloring pull-down, 
select Name. Now the new border is colored the light blue color you set when you named the 
boundary.  

For demonstration purposes, we will Erase part 
of this border, Extend it with an intentional 
mistake and then Replace the section with the 
mistake. 

• Click the Erase button. Then click the 
mouse twice, once at the beginning of 
the section that is to be removed and 
once at the end of the section. Then 
click the Finish button. The section of 
border that you drew along will 
disappear (Figure 3.7). 

• Click the Extend button and draw in the 
missing section of the border with an 
intentional bump and click Finish.  The 
inaccurate extension will be displayed 
(Figure 3.8A). 

• Click the Replace button and draw where the border should be (Figure 3.8B).  Make sure to start 
with your cursor on a border point that you want to keep and end on the opposite end of the 
error, on a border point you want to keep.  The function needs to know where exactly the 
replacement is going.  Click Finish.  The inaccurate section is properly replaced (Figure 3.8C). 

         
Figure 3.8 – Border extension and replacement. A) Extension with intentional mistake,  
B) Replaced extension, C) Finished border  

 
Figure 3.7 – Erasing a Portion of the border  

http://www.humanconnectome.org/
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• To delete just a few border points, before you have “Finished” the border, click the Undo button 
while the border is still red.  One click per border point.   

• If you want to delete a border before you have “Finished” it, click the Reset button while the 
border is still red.  

Editing borders, while in the Edit mode  makes it possible to delete completed/ 
“Finished” borders and edit the Properties for completed borders. 

• In the Borders mode pull-down select Edit. 

• Click the Delete button and then click on the border that you wish to delete.  It disappears. 

• Click the Properties button and then click on a desired border.  This brings up a box that allows 
you to edit the properties of that border (Name, Class, and associated colors). 

This popup also allows you to change the order of the border points by clicking the Reverse Point Order 
checkbox.   

Creating a Region Of Interest (ROI)  
There are two options for creating regions of interest using Create an ROI: create a Label ROI or a Metric 
ROI. 

For Label ROIs, you may be interested in creating your own or making additions to current Label files by 
creating unique ROIs.  This is possible through the Borders function: ROI. 

• Click Off the first layer (CIFTI LABELS parcellations_VGD11b.L.32k…) in the Overlay Toolbox.  
Switch the third layer to CIFTI SCALARS HCP_PhaseII_Q1_Unrelated20.sulc.32k_fs_LR.dscalar.nii 

• In the Borders mode pull-down select ROI.   

• In the Features Toolbox: Borders: Selection, make sure the checkbox for the ROI-for-avg-
connectivity: Myelin: Test-myelin-patch border we drew previously is selected. 

• Left click on the border. 

• A popup box will appear (Figure 3.9) 

o Leave the Type as the default “Label”. 

o Click the File: New button. In the box that 
pops up, you are able to change both the 
File Name and the Map Name. Both of 
these default to the border name often 
convenient)M, but to save some confusion 
we will rename them.   

 Change the File Name to Myelin_locations.label.gii and the Map Name to MT 
and Click OK. 

 
Figure 3.9 – Create ROI popup box  
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o Click the Edit button for Label Name, click New, enter MT as the Name and select a 
color for the new Label (here, we‘re using light blue (Green = 255 + Blue = 255), don’t 
choose red, since the Composite Parcellation Label File that we compare below has MT 
colored red). Click OK. 

o Click OK. 

• Back in the Overlay Toolbox, click the top layer CIFTI LABELS parcellations… On and set the Map 
to Composite Parcellation... 

• Set the second layer to the new file LABEL Myelin_locations.label.gii, click this layer On 

• Toggle layers 2 and 3, only, On to see the new Myelin_locations: MT label displayed on the 
surface (Figure 3.10). 

• Now toggle layer 1 on in order to see the Composite Parcellation location MT (red) compared 
with the Myelin label map over MT (light blue) (Figure 3.11).  

• Click off Display Borders 

• Click the information icon at the top of the Workbench window and click the RID button to clear 
the identified vertex. 

Foci Mode  

Creating a Focus 
Now we will demonstrate how to create a focus at the center of the myelin patch at MT in the Q1 
Unrelated 20 myelin map. 

 
Figure 3.10 – The newly created MT ROI 

 
Figure 3.11 – Comparison between new MT ROI 
and the Composite Parcellation 
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• Switch to View mode in the Toolbar. If the Toolbar is off, turn it on with the           in the upper 
right corner. 

• In the Overlay Toolbox, turn off the top layer and set the second layer to CIFTI SCALARS 
HCP_PhaseII_Q1_Unrelated20. MyelinMap_BC... Click the X in the upper left of the Overlay 
Toolbox to close it. 

• If it isn’t open already, open the Features Toolbox           in the Toolbar. 

• Click on Display Foci in Features Toolbox:Foci:. The foci from the loaded file Parcels_GV11… are 
displayed. 

• Click on Paste Onto Surface and set Coloring  to Name and Draw As to Spheres and changed 
Symbol Size to 5.0. Notice that none of the identified foci from the Parcels_GV11… file mark the 
myelin patch over area MT. 

• Pan and zoom to focus on MT. 

• Switch to Foci mode in the Toolbar. 

• The Foci: Create mode is now active.  Left click the center of the orange myelin patch over MT.  

• The Create Focus popup appears with the XYZ coordinates for the spot you just clicked filled in 
(Figure 3.12).  

o Click the New button to the right of 
the File field. Enter the new File 
name ‘Myelin_locations.foci’ and 
click Save. 

o Click the Add/Edit button next to 
the Name field. Click the New 
button. In the Name field, delete 
the default and enter ‘MT’. Keep 
the black focus default color. Click 
OK. 

o Click the Add/Edit button next to 
the Class field. Click the New button 
and enter ‘Visual Areas’ in the 
Name field, and slide the Red and 
Blue color sliders halfway to set a 
dark purple class color. Click OK. 

o Make sure the Project to Surface 
checkbox is clicked on, then hit OK. 

o A black focus should show up where you had clicked (Fig 3.13). 

• Anytime you left click in Foci: Create mode, the Create Focus popup will appear.  

 
Figure 3.12 – Create Focus popup 
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If you instead just want to 
identify a vertex to see 
information on it, right click 
and select the first option 
to Identify vertex… under 
mouse (Fig 3.13). 

Further down the list of 
right click options, is one to 
Create Focus at the nearest 
vertex to the place on the 
surface you right clicked 
(without clicking the Foci: 
Create New button). This 
option to create a focus is 
active in any mode (View, 
Border, or Foci) when you 
right click a structure.  

• To create a focus for a particular set of coordinates (rather than directly clicking on a structure), 
click the New button next to Foci:Create.  

o Click Name: Add/Edit.  

o In the popup (Figure 3.14), click New, enter the name ‘V1/V2’, and set the color to blue. 
Click OK 

o Keep the Class as ‘Visual Areas’.  

o In the XYZ fields, enter coordinates -16.00, -95.00, -19.00.  

o In the Comment field, enter “Created from coordinates at an area of high myelin 
content on the boundary between V1 and V2”. 

o Click OK. A blue focus should appear at the coordinates you entered in the middle of a 
patch of high myelin content at the border between V1 and V2. (Turn the surface to a 

 
Figure 3.13 – Right click options in any mode 
 

   
Figure 3.14 – Create New Focus from coordinates 
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posterior view to see the focus clearly).  

• You can also create a focus from the last vertex you ID’d (with a left click) in View mode.  

o Click on Foci Mode, then click on the Last ID button. 

o Enter the desired name, class and associated colors in the Create Focus popup and hit 
OK.  

• Foci:Edit mode allows you to Delete a focus or edit its Properties using the appropriate buttons.  

o To delete, click the Delete button and left click on the focus you want to delete. The 
focus will disappear from the structure and its name and color will be removed from the 
list in the Foci:Selection tab. 

o Similarly, to edit the properties of a focus, click the Properties button and left click on 
the focus you want to edit. An Edit Focus popup will appear and allows you to edit all 
fields set when the focus was created. 

 

Note: When you close Workbench, you will be notified that you have modified files. If you wish to save 
the test files, click on File►Save/Manage Files… at the top of the Workbench Window. In the Manage 
Data Files dialog that pops up, click on the appropriate Save and In Spec checkboxes to save the files 
and add them to the Spec file, respectively.  
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Chapter 4: Using wb_import and wb_command 
Besides the main GUI application, the Workbench software package provides command line interface 
programs wb_import and wb_command that allow you to perform many operations on data files. The 
command line interface allows for significantly improved efficiency when analyzing a large number of 
datasets.  

wb_import is a tool that is used to convert files into a format compatible with Workbench. 
wb_command is a program containing a growing number (currently, 124) operations that can be applied 
singly, or in combination, to process surface and/or volume data. 

Either program must be launched from the terminal (Linux/Mac) or Command Prompt (Windows).   For 
convenience of running the programs from any terminal or command window and within any directory, 
it is useful to set a user-specific environment variable path for wb_import and wb_command.    

Setting the Command Line Environment 
For Mac users:  

• Open a terminal window. 

• When you downloaded Workbench, if you moved the Workbench folder to Applications, add an 
environment variable path in your .cshrc or .bash file for wb_import and wb_command, such as 
(for tcsh/csh):   

setenv PATH /Applications/workbench/macosx64_apps/wb_import.app/Contents/MacOS:$PATH  

setenv PATH /Applications/workbench/macosx64_apps/wb_command.app/Contents/MacOS:$PATH  

 

For Linux users: 

• Open a terminal window. 

• Set your path to whatever directory you placed the unzipped 
workbench_linux64.beta_0.83/workbench/bin_linux64 folder.  

o To set the PATH in Bash shell, enter this command: 
echo 'export path=$path:/my/workbench/path' >> ~/.bashrc 

o To set the PATH in tcsh/csh shell, enter this command: 
echo 'set path = ($path /my/workbench/path)' >> ~/.cshrc 

 where ‘/my/workbench/path’ is the path to the workbench/bin_linux64 folder. 

• Log out and log back in to make the change take effect. 
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For Windows users:  

Within the ‘workbench_windows64.beta_0.83’ folder you unzipped when you downloaded the program, 
is the workbench\bin_windows64  folder that contains the executables for the ‘workbench’ application, 
‘wb_import’, and ‘wb_command’. 

wb_import and wb_command must be run from the Command Prompt program in Windows. In order to 
launch them from any directory at the Command Prompt, we must set an environment variable path.  

• Right click on the ‘Computer’ or ‘My Computer’ icon on your Desktop. Left click on Properties. 

• Click on Advanced System Settings. 

• Press the Environment Variables… button at the bottom of the popup. 

• Press the New… button under User variables. 

• Enter the following in the New User Variable dialog: 

Variable Name:  PATH 
Variable Value:  “C:\my\path\workbench_windows64.beta_0.83\workbench\bin_windows64”  

 where ‘\my\path’ is the path to the directory in which you downloaded the program 

• Press the OK button in the New User Variable dialog.   

• Press the OK button in the Environment Variables dialog.   

• Press the OK button in the System Properties dialog.   

• Using the Start Menu button, move the mouse over All Programs, and from the Accessories 
Menu, select Command Prompt. 

• In the Command Prompt Window, enter the command ‘wb_import’.  If the Path Environment 
variable has been set correctly, wb_import will launch.  If not, check the previous steps. 

wb_import: Converting Files to Workbench Format 
In addition to the files provided in this tutorial, you may want to convert your own structure, volume, 
and data files into Workbench format for visualization. This requires the use of wb_import, that is 
distributed with Connectome Workbench and is launched through the terminal interface (Linux/Mac) or 
Command Prompt (Windows).    

Converting Caret 5 Spec Files 
If you have Caret 5 format specification files, you can easily convert them (and the files listed within 
them) to Workbench format in one step. These tutorial instructions use the sample Caret5 spec files 
Conte69_atlas.L.164k_fs_LR.c5.spec and Conte69_atlas.R.164k_fs_LR.c5.spec as examples. Find your 
Caret5 spec files on your computer and note the full path of the directory in which they are located.  
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In Mac OSX or Linux: 

• Open a new terminal window so the environment for the wb_import command is activated.  

In Windows: 

• Open the folder containing the Caret5 file(s) on your computer. 

• Add a New folder to this directory and call it ‘wb_spec’ 

• Open the wb_spec folder 

• Open the Command Prompt from this folder by holding down Shift + right click, then left clicking 
on ‘Open command window here’ in the dropdown menu that appears.   

All platforms: 

• At the prompt, type ‘wb_import’ to launch the program. 

• Some basic information on running the tool will appear, including the two commands available: 
CONVERT DATA FILE TO WORKBENCH FORMAT   -data-file 
CONVERT SPEC FILE AND ITS DATA FILES TO WORKBENCH FORMAT   -spec-file 

• Type ‘wb_import  -spec-file’   

• More information about this command will appear, including the correct syntax for running the 
command: 
wb_import -spec-file <structure-name> <spec-file-name> 

• As noted in the command information, you will need to run this command once for each 
structure in the spec file that you are converting. You need to specify which structure (left, right, 
cerebellum) as part of the command.    

• This command will output a file in Workbench format with the same name as the input file. 
Therefore, it is best to run the command from a newly created, empty directory on a spec file in 
a different location to minimize the chances that any file is overwritten or corrupted if the 
command fails.  

• Mac/Linux users: create a new directory named ‘wb-spec’ and change to that directory (If you 
are following the directions for Windows, you should already be in the wb-spec directory): 
mkdir wb-spec 
cd wb-spec 

• Run the command with this syntax: 
wb_import -spec-file left /my_path/Conte69_atlas.L.164k_fs_LR.c5.spec 

where “/my_path/…” is the directory that contains the left hemisphere spec file you are converting. 

The log from the spec file conversion will appear. Note: You will see error messages for 
conversion of types of files (such as .topo or .scene files) because they are not file types 
currently supported in Workbench (aka. Caret7). These errors will not affect the conversion of 
allowed file types. 
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• Type ‘ls’ at the prompt to list the files in your wb-spec directory (or look at the contents of the 
directory in a Finder or explorer window). All the files that were converted by wb_import are 
written out to this directory in workbench format with the same name as they had in the Caret5 
format spec file.    

• Now run the command for the right hemisphere: 
wb_import -spec-file right /my_path/Conte69_atlas.R.164k_fs_LR.c5.spec 

Again, the log from the conversion will appear with error messages for unsupported file types. 

• Now that these spec files are in Workbench format, you may want to change their names using 
the move command to indicate the new format:   
mv Conte69_atlas.L.164k_fs_LR.c5.spec Conte69_atlas.L.164k_fs_LR.wb.spec  

mv Conte69_atlas.R.164k_fs_LR.c5.spec Conte69_atlas.R.164k_fs_LR.wb.spec 

• Now, each of these new spec files can be opened in Workbench separately. However, you may 
want to merge them into a single file containing information for both hemispheres.  

• To merge two spec files, you can use the wb_command operation –spec–file–merge. Type: 
wb_command -spec-file-merge 

to get an explanation of how to run the command. 

• To merge the two spec files above, you would use this syntax: 
wb_command -spec-file-merge /my_path/wb-spec/Conte69_atlas.L.164k_fs_LR.wb.spec 
/my_path/wb-spec/Conte69_atlas.R.164k_fs_LR.wb.spec 
/my_path/wb-spec/Conte69_atlas.LR.combined.164k_fs_LR.wb.spec 

wb_command: Making and manipulating Workbench files  
wb_command allows you to perform apply many operations on data files singly, or in combination, to 
process surface and/or volume data. The command line interface allows efficient, batch processing of 
neuroimaging data.  
 

• In a terminal or Command Prompt window, type ‘wb_command’ to launch the program. 
>wb_command 
 
Level: CONFIG 
Method: static void caret::VolumeFile::setVoxelColoringEnabled(bool) 
File:   
/Users/caret/caret7_development/mac64/caret7_source/src/Files/VolumeFile.cxx 
Line:   69 
Text:   Volume coloring is disabled. 
 
Workbench 
Version: Beta 0.83 
Qt Compiled Version: 4.8.3 
Qt Runtime Version: 4.8.3 
commit: fa2a65ebfacf903f413891fb23145e333fc55936 
commit date: 2013-08-12 10:27:48 -0500 
Compiled Debug: NO 
 
Information options: 
   -help                 print this help info 
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   -arguments-help       explain how to read the help info for subcommands 
   -version              print version information only 
   -list-commands        print all non-information (processing) subcommands 
   -all-commands-help    print all non-information (processing) subcommands and 
                            their help info - VERY LONG 

• As indicated, a list of the commands currently available and short description of each will appear 
when you type: 

>wb_command –list-commands 
 
-add-to-spec-file                     ADD A FILE TO A SPECIFICATION FILE 
-backend-average-dense-roi            CONNECTOME DB BACKEND COMMAND FOR CIFTI 
AVERAGE DENSE ROI 
-backend-average-roi-correlation      CONNECTOME DB BACKEND COMMAND FOR CIFTI 
AVERAGE ROI CORRELATION 
-cifti-average                        AVERAGE CIFTI FILES 
-cifti-average-dense-roi              AVERAGE CIFTI ROWS ACROSS SUBJECTS BY ROI 
-cifti-average-roi-correlation        CORRELATE ROI AVERAGE WITH ALL ROWS THEN 
AVERAGE ACROSS SUBJECTS 
-cifti-change-timestep                CHANGE THE TIMESTEP OF A CIFTI FILE 
-cifti-convert                        CONVERT TO OR FROM CIFTI 
-cifti-convert-to-scalar              CHANGE A CIFTI DIMENSION TO NAMED SCALAR MAPS 
-cifti-correlation                    GENERATE CORRELATION OF ROWS IN A CIFTI FILE 
-cifti-correlation-gradient           CORRELATE CIFTI ROWS AND TAKE GRADIENT 
-cifti-create-dense-timeseries        CREATE A CIFTI DENSE TIMESERIES 
-cifti-create-label                   CREATE A CIFTI LABEL FILE 
-cifti-cross-correlation              CORRELATE A CIFTI FILE WITH ANOTHER CIFTI 
FILE 
-cifti-dilate                         DILATE A CIFTI FILE 
-cifti-extrema                        FIND EXTREMA IN A CIFTI FILE 
-cifti-gradient                       TAKE GRADIENT OF A CIFTI FILE 
-cifti-label-import                   MAKE A CIFTI LABEL FILE FROM A CIFTI FILE 
-cifti-math                           EVALUATE EXPRESSION ON CIFTI FILES 
-cifti-merge                          MERGE CIFTI TIMESERIES, SCALAR, OR LABEL 
FILES 
-cifti-merge-dense                    MERGE CIFTI FILES ALONG DENSE DIMENSION 
-cifti-pairwise-correlation           CORRELATE PAIRED ROWS BETWEEN TWO CIFTI FILES 
-cifti-palette                        SET PALETTE ON A CIFTI FILE 
-cifti-parcellate                     PARCELLATE A CIFTI FILE 
-cifti-reduce                         PERFORM REDUCTION OPERATION ALONG CIFTI ROWS 
-cifti-reorder                        REORDER THE PARCELS OR SCALAR/LABEL MAPS IN A 
CIFTI FILE 
-cifti-replace-structure              REPLACE DATA IN A STRUCTURE IN A CIFTI FILE 
-cifti-resample                       RESAMPLE A CFTI FILE TO A NEW CIFTI SPACE 
-cifti-roi-average                    AVERAGE ROWS IN A SINGLE CIFTI FILE 
-cifti-rois-from-extrema              CREATE CIFTI ROI MAPS FROM EXTREMA MAPS 
-cifti-separate                       SEPARATE A CIFTI MODEL INTO METRIC OR VOLUME 
-cifti-separate-all                   SEPARATE MULTIPLE CIFTI COMPONENTS AT ONCE 
-cifti-smoothing                      SMOOTH A CIFTI FILE 
-cifti-transpose                      TRANSPOSE A CIFTI FILE 
-class-add-member                     ADD MEMBER AND GETTER/SETTER TO SOURCE CODE 
FILES (.h and .cxx) 
-class-create                         CREATE CLASS SOURCE CODE FILES (.h and .cxx) 
-class-create-algorithm               CREATE SOURCE CODE CLASS FILES (.h, .cxx) FOR 
ALGORITHM 
-class-create-enum                    CREATE SOURCE CODE CLASS FILES (.h, .cxx) FOR 
ENUMERATED TYPE 
-class-create-operation               CREATE SOURCE CODE CLASS FILES (.h, .cxx) FOR 
OPERATION 
-convert-affine                       CONVERT AN AFFINE FILE BETWEEN CONVENTIONS 
-convert-fiber-orientations           CONVERT BINGHAM PARAMETER VOLUMES TO FIBER 
ORIENTATION FILE 
-convert-matrix4-to-matrix2           GENERATES A MATRIX2 CIFTI FROM MATRIX4 
WBSPARSE 
-convert-matrix4-to-workbench-sparse  CONVERT A 3-FILE MATRIX4 TO A WORKBENCH 
SPARSE FILE 
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-convert-warpfield                    CONVERT A WARPFIELD BETWEEN CONVENTIONS 
-create-signed-distance-volume        CREATE SIGNED DISTANCE VOLUME FROM SURFACE 
-estimate-fiber-binghams              ESTIMATE FIBER ORIENTATION DISTRIBUTIONS FROM 
BEDPOSTX SAMPLES 
-fiber-dot-products                   COMPUTE DOT PRODUCTS OF FIBER ORIENTATIONS 
WITH SURFACE NORMALS 
-foci-list-coords                     OUTPUT FOCI COORDINATES IN A TEXT FILE 
-gifti-convert                        Convert a GIFTI file to a different encoding 
-label-dilate                         DILATE A LABEL FILE 
-label-mask                           MASK A LABEL FILE 
-label-resample                       RESAMPLE A LABEL FILE TO A DIFFERENT MESH 
-metadata-remove-provenance           REMOVE PROVENANCE INFORMATION FROM FILE 
METADATA 
-metadata-string-replace              REPLACE A STRING IN ALL METADATA OF A FILE 
-metric-convert                       CONVERT TO OR FROM METRIC FILE 
-metric-dilate                        DILATE A METRIC FILE 
-metric-extrema                       FIND EXTREMA IN A METRIC FILE 
-metric-fill-holes                    FILL HOLES IN AN ROI METRIC 
-metric-gradient                      SURFACE GRADIENT OF A METRIC FILE 
-metric-mask                          MASK A METRIC FILE 
-metric-math                          EVALUATE EXPRESSION ON METRIC FILES 
-metric-merge                         MERGE METRIC FILES INTO A NEW FILE 
-metric-palette                       SET THE PALETTE OF A METRIC FILE 
-metric-reduce                        PERFORM REDUCTION OPERATION ACROSS METRIC 
COLUMNS 
-metric-regression                    REGRESS METRICS OUT OF A METRIC FILE 
-metric-remove-islands                REMOVE ISLANDS FROM AN ROI METRIC 
-metric-resample                      RESAMPLE A METRIC FILE TO A DIFFERENT MESH 
-metric-rois-from-extrema             CREATE METRIC ROI MAPS FROM EXTREMA MAPS 
-metric-smoothing                     SMOOTH A METRIC FILE 
-metric-vertex-sum                    SUM VALUES ACROSS VERTICES IN A METRIC FILE 
-nifti-convert                        Convert a NIFTI 1 file to a NIFTI 2 file 
-nifti-information                    Display information about a Nifti/Cifti File. 
-probtrackx-dot-convert               CONVERT A .DOT FILE FROM PROBTRACKX TO CIFTI 
-set-map-name                         SET THE NAME OF A MAP IN A FILE 
-set-map-names                        SET THE NAME OF ONE OR MORE MAPS IN A FILE 
-set-structure                        SET STRUCTURE OF A DATA FILE 
-show-scene                           OFFSCREEN RENDERING OF SCENE TO AN IMAGE FILE 
-signed-distance-to-surface           COMPUTE SIGNED DISTANCE FROM ONE SURFACE TO 
ANOTHER 
-spec-file-merge                      MERGE TWO SPEC FILES INTO ONE 
-surface-affine-regression            REGRESS THE AFFINE TRANSFORM BETWEEN SURFACES 
ON THE SAME MESH 
-surface-apply-affine                 APPLY AFFINE TRANSFORM TO SURFACE FILE 
-surface-apply-warpfield              APPLY WARPFIELD TO SURFACE FILE 
-surface-average                      AVERAGE SURFACE FILES TOGETHER 
-surface-closest-vertex               FIND CLOSEST SURFACE VERTEX TO COORDINATES 
-surface-cortex-layer                 CREATE SURFACE APPROXIMATING A CORTICAL LAYER 
-surface-create-sphere                GENERATE A SPHERE WITH CONSISTENT VERTEX 
AREAS 
-surface-distortion                   MEASURE DISTORTION BETWEEN SURFACES 
-surface-flip-lr                      MIRROR A SURFACE THROUGH THE YZ PLANE 
-surface-flip-normals                 FLIP ALL TILES ON A SURFACE 
-surface-generate-inflated            SURFACE GENERATE INFLATED 
-surface-geodesic-distance            COMPUTE GEODESIC DISTANCE FROM ONE VERTEX TO 
THE ENTIRE SURFACE 
-surface-geodesic-rois                DRAW GEODESIC LIMITED ROIS AT VERTICES 
-surface-inflation                    SURFACE INFLATION 
-surface-information                  DISPLAY INFORMATION ABOUT A SURFACE 
-surface-match                        SURFACE MATCH 
-surface-modify-sphere                CHANGE RADIUS AND OPTIONALLY RECENTER A 
SPHERE 
-surface-resample                     RESAMPLE A SURFACE TO A DIFFERENT MESH 
-surface-smoothing                    SURFACE SMOOTHING 
-surface-sphere-project-unproject     DEFORM A SPHERE ACCORDING TO A REGISTRATION 
-surface-vertex-areas                 MEASURE SURFACE AREA EACH VERTEX IS 
RESPONSIBLE FOR 
-surface-wedge-volume                 MEASURE PER-VERTEX VOLUME BETWEEN SURFACES 
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-unit-test                            Unit Testing 
-volume-affine-resample               APPLY AFFINE TRANSFORM TO VOLUME AND RESAMPLE 
-volume-dilate                        DILATE A VOLUME FILE 
-volume-extrema                       FIND EXTREMA IN A VOLUME FILE 
-volume-fill-holes                    FILL HOLES IN AN ROI VOLUME 
-volume-gradient                      GRADIENT OF A VOLUME FILE 
-volume-label-import                  IMPORT A LABEL VOLUME TO CARET FORMAT 
-volume-label-to-surface-mapping      MAP A LABEL VOLUME TO A SURFACE LABEL FILE 
-volume-math                          EVALUATE EXPRESSION ON VOLUME FILES 
-volume-merge                         MERGE VOLUME FILES INTO A NEW FILE 
-volume-palette                       SET THE PALETTE OF A VOLUME FILE 
-volume-parcel-resampling             SMOOTH AND RESAMPLE VOLUME PARCELS 
-volume-parcel-resampling-generic     SMOOTH AND RESAMPLE VOLUME PARCELS FROM 
DIFFERENT VOLUME SPACE 
-volume-parcel-smoothing              SMOOTH PARCELS IN A VOLUME SEPARATELY 
-volume-reduce                        PERFORM REDUCTION OPERATION ACROSS SUBVOLUMES 
-volume-remove-islands                REMOVE ISLANDS FROM AN ROI VOLUME 
-volume-reorient                      CHANGE VOXEL ORDER OF A VOLUME FILE 
-volume-rois-from-extrema             CREATE VOLUME ROI MAPS FROM EXTREMA MAPS 
-volume-smoothing                     SMOOTH A VOLUME FILE 
-volume-to-surface-mapping            MAP VOLUME TO SURFACE 
-volume-warpfield-resample            RESAMPLE VOLUME USING WARPFIELD 
-wbsparse-merge-dense                 MERGE WBSPARSE FILES ALONG DENSE DIMENSION 
-zip-scene-file                       ZIP A SCENE FILE AND ITS DATA FILES 
-zip-spec-file                        ZIP A SPEC FILE AND ITS DATA FILES 
 
• For a full explanation and the syntax used to run each command, type: 
 wb_command [-command-name] 

Creating a New or Add to an Existing Spec file 
You can create a new spec file, or add a file to an existing spec file, using the wb_command  –add-to-
spec-file operation. 

• Type the following to get a description of the operation:  
>wb_command –add-to-spec-file 
 
ADD A FILE TO A SPECIFICATION FILE 
   wb_command -add-to-spec-file 
      <specfile> 
      <structure> 
      <filename> 
 
      The resulting spec file overwrites the existing spec file.  If the spec 
      file doesn't exist, it is created with default metadata.  The structure 
      argument must be one of the following: 
 
      CORTEX_LEFT 
      CORTEX_RIGHT 
      CEREBELLUM 
      ACCUMBENS_LEFT 
      ACCUMBENS_RIGHT 
      ALL_GREY_MATTER 
      ALL_WHITE_MATTER 
      AMYGDALA_LEFT 
      AMYGDALA_RIGHT 
      BRAIN_STEM 
      CAUDATE_LEFT 
      CAUDATE_RIGHT 
      CEREBELLAR_WHITE_MATTER_LEFT 
      CEREBELLAR_WHITE_MATTER_RIGHT 
      CEREBELLUM_LEFT 
      CEREBELLUM_RIGHT 
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      CEREBRAL_WHITE_MATTER_LEFT 
      CEREBRAL_WHITE_MATTER_RIGHT 
      CORTEX 
      DIENCEPHALON_VENTRAL_LEFT 
      DIENCEPHALON_VENTRAL_RIGHT 
      HIPPOCAMPUS_LEFT 
      HIPPOCAMPUS_RIGHT 
      INVALID 
      OTHER 
      OTHER_GREY_MATTER 
      OTHER_WHITE_MATTER 
      PALLIDUM_LEFT 
      PALLIDUM_RIGHT 
      PUTAMEN_LEFT 
      PUTAMEN_RIGHT 
      THALAMUS_LEFT 
      THALAMUS_RIGHT 
 
      Descriptions of parameters and options: 
 
      <specfile> - the specification file to add to 
      <structure> - the structure of the data file 
      <filename> - the path to the file 

• Create the new spec file “test.spec” (that contains the sample left cortex file 
Conte69.L.inflated.164k_fs_LR.surf.gii) in your wb-spec directory :  

>wb_command –add-to-spec-file test.spec CORTEX_LEFT 
Conte69.L.inflated.164k_fs_LR.surf.gii 

• Note: the structure argument (e.g. CORTEX_LEFT) must be typed in all caps. 

• Check the contents of your wb-spec directory to see that test.spec was created.  

• Now add another file (the inflated right cortex file Conte69.R.inflated.164k_fs_LR.surf.gii) to this 
newly created spec file with the command:  

>wb_command –add-to-spec-file test.spec CORTEX_RIGHT 
Conte69.R.inflated.164k_fs_LR.surf.gii 

• Check the contents of your wb-spec directory to see that test.spec was created. 

• To open the test.spec file in workbench, type: 
>workbench test.spec 

• Both the CortexLeft and CortexRight inflated surface files should be listed in the Spec File Data 
File Selection dialog. Press the Load button. 

• Four Viewing Tabs should automatically open: (1) Montage, (2) All, (3) Cortex Left, and (4) Cortex 
Right and you should be able to interact with both left and right inflated surfaces in the tabs. 

• If desired, continue to add other files to the test.spec file using the –add-to-spec-file command 
and open them in Workbench. Note: All data files must have a structure designated in the 
command (e.g. CORTEX_LEFT) to be added to the spec file. 
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Adding to an Existing Spec file in the Workbench GUI 
The GUI interface of Workbench affords another way to add files to an existing spec file. Here we 
use the example of adding a label file to a spec file. With the example test.spec file open in the 
Workbench GUI: 

• Click on File►Open File… at the top of the Workbench Window. 

• Change Files of type: to Label Files (*.label) in the Open file dialog.  

• Select parcellations.L.composite-cortical.164k_fs_LR.label.gii by holding down the 
command/control key as you left click. 

• Press Open. 

• You should see the new label file appear as a file selection option in the Layers tab of the 
Overlay Toolbox.  

• Click on File►Save/Manage Files… at the top of the Workbench Window. 

• The label file you just opened is listed in the Manage Data Files dialog, but it is not added to the 
spec file by default. If you want to save the file to the test.spec file, check the ‘In Spec’ checkbox 
to the left of the file name. 

• Check the Save checkbox beside the Spec file name to save the changes to the spec file (the 
addition of the new file).  
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Appendix: Tutorial for Q1 Unrelated 20 Dataset (v1b)  
 

Connectome Workbench Tutorial  
for HCP Group-Average Demo Version 1b 

Data  
(Q1 Unrelated 20)  

11 June 2013 

**This Tutorial for HCP Group-Average Demo Version 1b Data (Q1 Unrelated 20) is 
compatible with Workbench Beta v0.83** 

Introduction 
Connectome Workbench (herein called ‘Workbench’) is a freely available software platform for 
visualization and analysis of neuroimaging data.  It is customized for handling data from the Human 
Connectome Project (HCP), including functional and structural connectivity and task-fMRI, using 
combined surface and volume visualization.  
 
This tutorial is written specifically to aid in navigating the HCP group-average demo version 1b (Q1 
unrelated 20) task-fMRI and functional connectivity data originally released on 5 March 2013 and 
updated on 11 June 2013.  The updated dataset includes files in CIFTI file format that are compatible 
with Workbench Beta 0.83 (see below).  Note that this HCP Q1 group-average demo dataset was 
processed using Version 1 preprocessing pipelines (plus additional processing), rather than the Version 2 
preprocessing pipelines that have been applied to all Q1 and Q2 individual subjects in the Q2 data 
release (see the HCP Q2 Release Reference Manual for more information). 
 
For a more extensive introduction to using Workbench, download the Connectome Workbench Beta 
v0.83 Tutorial and User Guide and associated dataset.  
 
We encourage user feedback to help identify and prioritize refinements and needed features. The HCP-
users public discussion email list is an open forum for discussing such issues.  You can join at 
http://www.humanconnectome.org/contact/#subscribe.  Once you have subscribed, you can set 
preferences to receive hcp-users postings to the list as individual messages or as a digest. Please send 
bug reports and suggestions to the list by emailing hcp-users@humanconnectome.org. 

http://www.humanconnectome.org/
http://humanconnectome.org/documentation/Q2
http://humanconnectome.org/connectome/get-connectome-workbench.html
http://humanconnectome.org/connectome/get-connectome-workbench.html
http://www.humanconnectome.org/contact/#subscribe
mailto:hcp-users@humanconnectome.org
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Figure 1 – Connectome Workbench Splash Screen 
 

ConnectomeDB and Tutorial Data 
Besides handling locally stored data files, Workbench can access data files stored in ConnectomeDB, a 
web-accessible database that handles all HCP data modalities (MRI, MEG/EEG, and behavioral data).  
This interactivity will be critical, given the complexity of the datasets and the large file size for some data 
types (e.g., ‘dense connectome’ files currently exceed 30 GB per subject).  To circumvent downloading 
of these large files, connectivity maps for user-selected subjects and regions of interest can be extracted 
on the fly from ConnectomeDB and transmitted within seconds to Workbench through an internet 
connection. For this tutorial, using Workbench Beta v0.83, the Workbench interaction with 
ConnectomeDB involves a single step: opening a dense connectome file from ConnectomeDB through 
the Open Location option in the File menu (see Viewing Functional Connectivity below).  

• This tutorial uses dense functional connectome data that are for demonstration purposes only.  
You will need to register and accept a Data Use Agreement that acknowledges this stipulation.  
(This restriction is necessary because the advanced methods used to analyze the connectivity 
data have not been published or fully vetted).  This restriction does not apply to the group-
average task-fMRI, myelin maps, and other surface and volume data that are part of the tutorial 
dataset. 

• Unprocessed and minimally processed image data and behavioral data being released as part of 
the HCP Quarter 2 Data release is available for download and can be used freely by registering 
and accepting a separate Data Use Agreement at http://humanconnectome.org/data/.  

Workbench Orientation 
This section is to provide a quick orientation to Workbench (and its associated file types) for the 
purposes of exploring the group average HCP Q1 data provided. For a more comprehensive introduction 
to Workbench, please download and check out the Workbench Beta 0.83 tutorial. 
 
One major enhancement in Workbench Beta 0.83 is the utilization of data files that include maps of both 
the left and right cerebral hemispheres in a single file using the CIFTI file format.  For example, myelin 
maps for both hemispheres are contained in a single *.dscalar.nii file type; cortical parcellations for both 
hemispheres are contained in a single *.dlabel.nii file.  The scenes illustrated herein make use of these 
cifti files, but the downloaded datasets also include conventional hemisphere-specific GIFTI files 
(*.shape.gii; *.label.gii).   

Workbench Splash Screen 
When you launch Workbench, a splash 
screen opens (Figure 1), showing a list of 
Specification files (herein called “Spec Files”) 
in the directory path you are currently 
opening Workbench from, plus Recently 
opened Spec Files, if you have launched 
Workbench before.  

http://www.humanconnectome.org/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-ConnectomeDB
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-DenseConnectome
http://humanconnectome.org/connectome/get-connectome-workbench.html
http://humanconnectome.org/data/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-SplashScreen
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-SplashScreen
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Figure 2 - The Open File Dialog  
 

 
Figure 4 – The Scenes box   

 
Figure 3 - The Open Spec File Dialog  

A Specification File contains an organized set of data files for loading into the program at once (e.g., 
surface, volume, ‘label’, and ‘metric’ files).  

• For now, click the Skip button to launch Workbench without opening a file. 

Opening a Spec File and Loading Scenes 

• In the Workbench Menu bar, located at the top of your 
screen (Mac) or top of the Workbench window (Linux/PC), 
select File►Open File… (shortcut for Mac: command + O, 
Linux/PC: control + O) to display the Open File Dialog.  

• In the Open File Dialog (Figure 2), Navigate to the folder 
or directory that contains the data, the 
HCP_WB_Tutorial_Beta0.83 folder.  

o The default file type filter is 
Specification Files (*.spec). 

o Note: if you started from a terminal 
window in the directory containing 
the tutorial dataset, the tutorial spec 
file would already be available. 

• Select the desired file: 
HCP_beta0.83_tutorial.32k_fs_LR.wb.spec 
and click the Open button. The Open Spec 
File Dialog (Figure 3) will appear, showing 
the files in this particular spec file, grouped 
into 9 types: Border, Dense, Dense Label, 
Dense Scalar, Dense Data Series, Foci, Scene, 
Surface and Volume.  

• Click Load Scenes at the bottom left of the 
dialog to open the scene file necessary for 
the first section of this tutorial. The Specification File 
Dialog will automatically close once the scene file is 
loaded (a few seconds).  

• The Scenes box (Figure 4) will appear.  

  

http://www.humanconnectome.org/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-SpecFile
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-Menubar
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-Scene
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  A              B 

                 
  Figure 5 - The Workbench Viewing Window A) Vertical Orientation B) Horizontal Orientation 

Often views in Workbench require several steps to set up, so we have provided scene files that 
offer a quick way to load views that show off the HCP Q1 data provided and many features of 
Workbench.  

• In the Scene File drop-down menu, select HCP_WB_Tutorial_Beta0.83_part2.scene.  In the 
Scenes field our first scene: “HCP_unrelated20 avg inflated, avg sulc should be highlighted, 
indicating that it is selected.  

• Click Show to load the scene.  

Scene 1: HCP_unrelated20 avg inflated, avg sulc 
This scene shows group average surfaces and volumes of a set of 20 unrelated Q1 subjects in this 
dataset. It also provides a convenient backdrop to introduce you to the layout and some of the general 
features of Workbench.  

Workbench Window Layout 
The scene opens with a montage of lateral and medial views of the group average inflated cortical 
surfaces of both hemispheres in the Viewing Area of the Workbench Window (“Connectome 
Workbench 1”).  

The Workbench Window contains five Viewing tabs: (1) Cortex Left, (2) Cortex Right, (3) Montage, (4) 
Volume, and (5) All. (You may not see the 5th until the window is enlarged.)  

The Viewing Area defaults upon opening to view tab 3 (the Active Tab) showing a montage of lateral 
and medial views of the surfaces of both hemispheres. Components of the Workbench Window are 
shown in Figure 5.  

http://www.humanconnectome.org/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-Scene
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-ViewingArea
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-WorkbenchWindow
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-ViewingTabs
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-ViewingArea
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-ActiveTab
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The Overlay Toolbox can be displayed in two locations/orientations Figure 5A and B. On startup, the 
choice is automatically made based on the resolution of your monitor (if the vertical resolution is 800 or 
less, the overlay toolbox will be on the left).  

For the purposes of this tutorial, all instructions and figures assume you are using the horizontal 
orientation layout (Figure 5B), with the Overlay Toolbox attached to the bottom of the Viewing Area.  

• Press the left mouse button and drag your mouse anywhere in the Viewing Area to rotate the 
surfaces.  

• To zoom, scroll your mouse wheel up and down anywhere in the Viewing Area. If you don’t have 
a mouse wheel, press the command (Mac)/control (Linux/PC) key while pressing the left mouse 
button and moving your mouse up and down. 

• Click on Tab (1) Cortex Left. This shows the inflated left cortical surface. Click on Tab (2), which 
shows the inflated right cortical surface.  

• Click on Tab (4). This shows a montage of 9 group average volume slices. Note that even though 
this is a group average volume, there are clear boundaries between the gray and while matter 
regions reflecting the high quality of the HCP data.  

• Click on Tab (5) All. Drag the surface up and to the left to rotate the surface and volume (whole 
brain) and see that group average midthickness surfaces of both hemispheres and all 3 volume 
planes (parasagittal, coronal, axial) are visible.  

• Click through the tabs again and notice that the Toolbar changes when you switch tabs/views. 

• Try out the other buttons and dropdowns in the Toolbar to get a sense of what they do.  

• Click back to Tab (3) Montage. The Montage Selection section of the Toolbar lets you switch 
between brain structures for each hemisphere. For this data, you can select very inflated, 
midthickness (halfway between the white matter boundary and the pial surface), and inflated 
population-averaged surfaces for the HCP_Q1 Unrelated 20 subjects.  

**Tip:  Whenever you encounter any dropdown menu in Workbench, you can click or hover 
your mouse over the menu and quickly browse through selections using your mouse scroll 
wheel, or by typing a letter to search through selections by name.    

Scene 2: Average Myelin on inflated surface 
• In the Scenes Dialog, select “Average Myelin on inflated surface (HCP unrelated 20)” and click 

Show to load the scene. Leave the Scenes Dialog open.  

Note:  If you had inadvertently closed the Scenes Dialog, you can reopen it by clicking the 
clapboard        button in the upper right of the Workbench Window. 

This scene shows the same group average surfaces from Scene 1, but now overlaid with a map of myelin 
content averaged across the 20 unrelated subjects.  

http://www.humanconnectome.org/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-OverlayToolbox
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-Toolbar
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Figure 6 – Vertex Identification and the Information Box  

• Rotate the surfaces (press the left mouse button and drag your mouse). Red and orange 
represent heavily myelinated regions, purple and black represent areas of low myelin content 
(Glasser & Van Essen, 2011).  

o There is heavy myelination in much of the occipital lobe, including the orange-yellow 
target-like patch around where area MT should be, near the occipito-temporal junction.  

• Click on the surface within this 
patch over area MT (see Figure 6). 
The Information box will pop up.  

• In the Viewing Area, a white sphere 
should be visible at the 
grayordinate (i.e. cortical surface 
vertex or gray-matter volume voxel) 
you selected.  Your viewing window 
should look like Figure 6.     

• Information on the grayordinate 
that you clicked is listed in the 
Information box. For example, the 
XYZ coordinates and the labels 
assigned to the identified vertex are 
shown. Information (e.g. label 
names, metric values) on the vertex you selected is pulled from all currently loaded files for the 
structures being viewed, whether or not they are currently being displayed.  
 

Note:  The next eight scenes show different types of task contrasts from the HCP Task-fMRI analyses.  If 
you want to skip some or all of these exemplar Task-fMRI scenes, you may proceed at any time to the 
Viewing Functional Connectivity section near the end. 

Scene 3: 2back – 0back (WM, tfMRI), surfaces, grayordinate-
smoothed 

• Select “2back – 0back (WM, tfMRI), surfaces, grayordinate-smoothed (HCP unrelated 20)” in 
the Scenes Dialog box and click Show to load the scene. Leave the Scenes Dialog open.  

This scene shows the group average 2back-0back contrast of the HCP Working Memory task on the 
inflated surfaces. The fMRI data processing included grayordinate-constrained smoothing (4 mm FWHM, 
respecting cortical surface topology and subcortical parcel boundaries).  This has advantages over the 
volume-based smoothing that is conventionally applied to fMRI data (see below and Glasser et al. 2013, 
Barch et al., 2013).  Additionally, the averaging across subjects occurs in the grayordinate space, which 
in which the cerebral cortex is better aligned across subjects because of surface-based registration.   

http://www.humanconnectome.org/
http://www.jneurosci.org/content/31/32/11597.long
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-Brainordinate
http://www.sciencedirect.com/science/article/pii/S1053811913005053
http://www.sciencedirect.com/science/article/pii/S1053811913005272
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Figure 8 – Volume slice montage, showing group-
average task contrast for the 2-back vs 0-back HCP 
working memory task displayed on subcortical 
grayordinates.  

 

 

 
Figure 7 – Cortical surface montage, showing group-
average task contrast for the 2-back vs 0-back HCP 
working memory task. 

 

Figure 7 shows the unthresholded activation maps from the 2-back vs 0-back task contrast.  Activations 
related to working memory are most prominent in lateral prefrontal cortex but also include anterior 
cingulate cortex and lateral parietal cortex.    

The color bar in the lower left shows a 
maximum z-statistic value of 4.5 and minimum 
of -3.8.  (In this and other figures, the color bars 
span the +/- 98% range of z-values; the actual 
ranges are higher.  Options for setting z-statistic 
thresholds, adjusting the palette colors, etc. are 
available using the Layers: Settings: ‘wrench’ 
icon, as explained in the Workbench 0.7 
tutorial.)  

In this task, participants were presented with 
blocks of trials that consisted of pictures of 
places, tools, faces and body parts (non-
mutilated parts of bodies with no “nudity”). The 
participants are asked to perform a working 
memory task to remember the picture 2 
pictures back (2 back condition) or remember 
the picture they just say (0 back condition).  

Scene 4: 2back – 0back 
(WM, tfMRI), Vol-slices, 
grayordinate-smoothed 

• Select “2back – 0back WM, tfMRI), Vol-
slices, grayordinate-smoothed (HCP 
unrelated 20)” in the Scenes Dialog box 
and click Show to load the scene. Leave 
the Scenes Dialog open.  

This scene (Figure 8) shows the same 2back-
0back contrast of the HCP Working Memory 
task in Volume slices, but only showing 
subcortical grayordinates (gray-matter voxels, 
including the cerebellum).   Prominent bilateral 
activations are evident in lateral cerebellar 
cortex.  

 

  

http://www.humanconnectome.org/
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Figure 10 – Group-average task contrast for the 
Faces vs average of all objects from the HCP 
working memory task.  The inflated cortical 
surfaces are rotated to better show the face-
selective activation in ventral temporal cortex 
(lower panels). 

 

 
Figure 9 – Volume slice montage, showing group-
average task contrast for the 2-back vs 0-back HCP 
working memory task generated by a volumetric 
analysis (4mm FWHM volume smoothing).   

 

Scene 5: 2back – 0back (WM, tfMRI), volume-smoothed 
• Select “2back – 0back (WM, tfMRI), volume-smoothed (HCP unrelated 20)” in the Scenes 

Dialog box and click Show to load the scene.  

This scene (Figure 9) shows the same 2back-
0back contrast of the HCP Working Memory task 
in conventional volume slices. For this analysis, 
smoothing (4 mm FWHM) was done in volume 
space, which increases spatial blurring across 
sulcal banks.  Similarly, cortical activations 
across subjects in volume space induces greater 
blurring.   

Activations are visible in lateral prefrontal, 
anterior cingulate, lateral parietal, and 
cerebellar cortex, similar to those shown in the 
preceding two figures.  The peak z-statistic from 
the volume-average analysis is 4.2 (not shown 
here, but revealed by pressing the color bar icon 
in Overlay Toolbox: Layers), which is lower than 
that from the grayordinate-constrained analysis 
shown above.  Various advantages of surface-
based compared to volume-based analysis and 
visualization are discussed elsewhere (Glasser et 
al. 2013).  

Scene 6: Faces – average 
(tfMRI), surfaces, 
grayordinate-smoothed 

• Select “Faces – average (tfMRI), surfaces, 
grayordinate-smoothed (HCP unrelated 
20)” in the Scenes Dialog box and click 
Show to load the scene.  

This scene (Figure 10) shows the grayordinate-
smoothed analysis of the group-average Faces vs. 
Average contrast of the HCP Working Memory task 
displayed on the inflated surfaces.  

The surfaces have been rotated in the montage 
view so that you can see the strongest task 
activation in ventral occipito-temporal cortex, in 

http://www.humanconnectome.org/
http://www.sciencedirect.com/science/article/pii/S1053811913005053
http://www.sciencedirect.com/science/article/pii/S1053811913005053
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Figure 11 – Group-average task contrast for the 
Places vs average of all objects, from the HCP 
working memory task.   

 

the general location expected from numerous published studies.   The peak z-statistic is 3.3, indicating a 
weaker overall task activation compared to the 2-back vs. 0-back task. 

This contrast is part of the same working memory task described above, but compares the 0-back + 2-
back memory of pictures of Faces with the 0-back + 2-back memory of the average of all the pictures 
presented (places, tools, faces and body parts).   

Scene 7: Places – average (WM, tfMRI), surfaces, 
grayordinate-smoothed 

• Select “Places – average (tfMRI), surfaces, grayordinate-smoothed (HCP unrelated 20)” in the 
Scenes Dialog box and click Show to load the scene.  

This scene (Figure 11) shows the group-average 
Places vs. Average contrast of the HCP Working 
Memory task from the 20 unrelated subjects, 
displayed on the inflated surfaces. This data is 
grayordinate-smoothed as above.  Strong 
activations are visible in three regions of posterior 
cortex, including the parahippocampal cortex, the 
inferior part of the anterior bank of the parieto-
occipital sulcus, and cortex in and around the 
transverse occipital sulcus, similar to activations 
reported in previous studies (e.g., Nasr et al. 2011), 
The peak z-statistic is 4.5, substantially stronger 
than that for the face activation map.   

This contrast is part of the same working memory 
task described above, but compares the 0-back + 2-
back memory of pictures of Places with the 0-back 
+ 2-back memory of the average of all the pictures 
presented (places, tools, faces and body parts).   

  

http://www.humanconnectome.org/
http://www.jneurosci.org/content/31/39/13771.long
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Figure 12 – Group-average map for the Story vs 
Math task contrast from the HCP Language task.   

 

 

 
Figure 13 –Group-average map for the Theory Of 
Mind (TOM) vs Random movement task contrast 
from the HCP Social task. 

 

 

 

Scene 8: Story – Math (Language tfMRI), surfaces, 
grayordinate-smoothed 

• Select “Story – Math (Language tfMRI), surfaces, grayordinate-smoothed (HCP unrelated 20)” 
in the Scenes Dialog box and click Show to load the scene.  

This scene (Figure 12) shows the group-average 
Story vs. Math contrast of the HCP Language 
Processing task, displayed on the inflated 
surfaces.  Strong activations are evident in many 
regions, including anterior temporal cortex, 
posterior parietal cortex, and posterior 
cingulate cortex.  The peak z-statistic is 5.0. 

In this task, participants were presented a story 
task (brief auditory stories, followed by a 2-
alternative forced-choice question that asks 
participants about the topic of the story) or a 
math task (auditorially presented addition and 
subtraction problems, followed by two choices 
for the correct arithmetic answer, e.g., “twenty-
nine or twenty-six”).  

 

Scene 9: TOM vs Random 
(Social, tfMRI), surfaces, 
grayordinate-smoothed 

• Select “TOM vs Random (Social, tfMRI), 
surfaces, grayordinate-smoothed (HCP 
unrelated 20)” in the Scenes Dialog box 
and click Show to load the scene.  

This scene (Figure 13) shows the group-average 
TOM (theory of mind) vs. random motion 
contrast of the HCP social cognition (theory of 
mind) task.  Strong activations (up to z = 4.3) are 
evident in the superior temporal sulcus, area 45 
of lateral prefrontal cortex, and several other 
regions of occipital-temporal cortex. 

In this task, participants were presented with 
objects (squares, circles, triangles) that either 

http://www.humanconnectome.org/
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Figure 14 – Group-average map for the Relational 
vs Match task contrast from the HCP Relational 
task. 

 

 

 

 

interacted in some way, or moved randomly on the screen, then participants judged whether the 
objects had a mental interaction (an interaction that appears as if the shapes are taking into account 
each other’s feelings and thoughts), Not Sure, or No interaction.  

Scene 10: Relational vs Match (tfMRI), surfaces, grayordinate-
smoothed 

• Select “Relational vs Match (tfMRI), surfaces, grayordinate-smoothed (HCP unrelated 20)” in 
the Scenes Dialog box and click Show to load the scene.  

This scene (Figure 14) shows the group-average 
contrast comparing relational activations (subjects 
judging whether one pair of objects are related in 
shape or texture to another pair of objects) with 
match activations (subjects matching the shape or 
texture of one object with one of a pair of 
presented objects).  

This task did not generate strong activations (peak 
z-statistic = 2.8), but candidate activations which 
may be validated using a larger sample size 
include a swath of dorso-lateral prefrontal cortex 
as well as a patch of dorsal occipital cortex. 

  

http://www.humanconnectome.org/
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Figure 15 – Open Location Dialog  

Return to Scene 1: Viewing Functional Connectivity 
Now we return to Scene 1, which provides a template for viewing resting-state fMRI “dense” functional 
connectivity retrieved from ConnectomeDB the group average inflated surfaces. 

• Select Scene 1 (“HCP_unrelated20 avg inflated, avg sulc) in the Scenes Dialog box and click 
Show to load the scene. 

This section shows how to access, display, and interact with group averaged functional connectivity data 
from the HCP Q1 20 unrelated subjects on the cortical surface and in subcortical volumes.  

Functional connectivity data is derived from correlations between grayordinates in the resting state 
BOLD data.  Dense connectome files that show functional connectivity are REALLY big (~30 GB for 
current resolution). Because of their size, these files are stored in ConnectomeDB, which can tap into 
these large files as needed to view particular connectivity maps of interest.   

• In the Menu bar, select File►Open Location… (shortcut 
for Mac: command + L, Linux/PC: control + L).  

• A popup will appear as shown in Figure 15. Enter your 
ConnectomeDB username and password (same as you 
used to download data for Workbench). 

• Press Open Location: Standard. The default selection 
should be: “HCP-Q1_ Correlation with Mean Gray 
Regression (Avg 20)”  (If a different choice is shown, use 
the pull-down menu to make this selection.) 

As a reminder, the dense connectome data are for demonstration purposes only.  The Q1 
Open Access Data Use Agreement you agreed to in order to access the tutorial data 
acknowledges this stipulation.  (This restriction is necessary because the advanced methods 
used to analyze the functional connectivity data have not been published or fully vetted).   

• Click OK. It will take a few seconds to access the file over the internet. This step makes the 
selected 30 GB dense connectome file accessible, but (fortunately!) does not attempt to load 
the file. 

The dataset is from 80 scan sessions (20 subjects, 15 min/scan, for a total of 20 hours of scan time).  
Data were averaged across subjects using surface based registration for cerebral cortex and 
nonlinear volume registration for subcortical and cerebellar voxels.  Minimal spatial smoothing 
(2mm FWHM) was done.  Preprocessing and de-noising were carried out as described in Glasser et 
al. 2013 and Smith et al., 2013.  

• Click on the Layers tab.  

• Use the top layer’s File dropdown and select CONNECTIVITY cifti-average?resource=HCP-
Q1:Q1:Demo_HCP_unrelated20_FunctionalConnectivity_mgt-regression  

• Toggle the top layer ‘On’. 

http://www.humanconnectome.org/
https://wiki.humanconnectome.org/display/WBPublic/Workbench+Glossary#WorkbenchGlossary-DenseConnectome
https://wiki.humanconnectome.org/display/aWB/Workbench+Glossary#WorkbenchGlossary-ConnectomeDB
http://www.sciencedirect.com/science/article/pii/S1053811913005053
http://www.sciencedirect.com/science/article/pii/S1053811913005053
http://www.sciencedirect.com/science/article/pii/S1053811913005338
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Figure 16 – Comparing functional connectivity for three brain locations.  

 

• Click on the left hemisphere surface in the ventral part of the precentral gyrus, approximately 
the same place as the highlighted vertex in Figure 16A (white arrow, upper left).  

This shows a map of functional connectivity map associated with the face representation in motor 
cortex. With this color palette, brain regions that are positively correlated (by Pearson’s r-value that 
has been Fisher transformed) to the identified grayordinate are yellow, orange, and red; those that 
are negatively correlated (after regression of the mean gray-matter timeseries) are displayed in 
blue, green, and indigo.  

• Click on the yellow location on the postcentral gyrus (white arrow in Figure 16B) to view the 
similar functional connectivity map for the face representation of somatosensory cortex.  

• Now click a green or blue area in the supramarginal gyrus (white arrow in Figure 16C). You will 
see a much different connectivity pattern than for either of the previous maps (Figure 16C). This 
demonstrates how nearby brain regions can have very different functional connectivity from 
each other in the resting state. 

Comparing functional connectivity maps: full correlation vs. regression of the mean gray 
timecourse.  

• Select File►Open Location…  

• Select “HCP-Q1 Full Correlation (Avg 20)” from the pull-down menu under “Standard”.  

This dense connectome is from the same dataset as the preceding one, except that 
regression of the mean gray timeseries was not carried out.  

• Use the second layer’s File dropdown and select CONNECTIVITY cifti-average?resource=HCP-
Q1:Demo_HCP_unrelated20_FunctionalConnectivity_FullCorrel   

• In Toolbox Overlay: Layers, turn the second layer On 

• In the Information box, click on RID to remove any previously selected vertices  

• Click on a vertex in the left supramarginal gyrus, close to that shown in Figure 17A.  

• In Toolbox Overlay: Layers, turn the first layer Off. 

http://www.humanconnectome.org/
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Figure 17 – Alternative representations of functional connectivity maps using an exemplar seed in 
the left supramarginal gyrus (black arrows).  A.  Functional connectivity map after regression of the 
mean gray timecourse (MGT).  B.  Full correlation functional connectivity map for the same seed 
location.  

The functional connectivity map should appear similar to that in Figure 17B.  Most of the map will 
show positive correlations, but a few locations show negative values, indicating an anti-correlation 
even without regression of the mean gray timeseries (MGT). 

The interpretation of both types of functional connectivity map is complex.  Neither the full 
connectivity map nor the MGT-regressed map represents ‘ground truth’ anatomical connectivity 
(see Smith et al., 2013; Glasser et al. 2013; Van Essen et al., 2013).  Having both available for the 
same datasets should facilitate evaluation of the relative strengths and limitations of each way of 
representing functional connectivity.   Alternative representations, such as partial correlation, can 
also be explored (see Smith et al., 2013).  It is likely that this will remain a topic of ongoing debate 
and discussion in the field.   

 

http://www.humanconnectome.org/
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Glossary 
Active tab is the currently selected viewing tab at the top of the Workbench Window. The Overlay and 
Features Toolboxes provide options for viewing that apply only to the Active tab.  
 
Brainordinate is a brain location that can be specified by a surface vertex (node) or a volume voxel.  
Brainordinates include grayordinates (gray-matter vertices or voxels) and whiteordinates (white matter 
voxels).  CIFTI files (see below) contain a list of brainordinates to handle combined surface/volume 
representations.   
 
CIFTI file is a new file format that stores data from surfaces (vertices) and volumes (voxels) concurrently 
in a single file comprising a listed set of brainordinates.  The volume component of a CIFTI file can be any 
selected list of voxels (e.g., only subcortical gray-matter voxels) that need not conform to cuboidal or ‘N 
x M x O’ volumetric dimensions.  See http://www.nitrc.org/projects/cifti/ for a detailed exposition of the 
CIFTI file format.  CIFTI files are consistent with the NIFTI-2 file format and by convention have the 
extension .nii.  Workbench currently supports CIFTI files for dense scalar (*.dscalar.nii), dense time 
series (*.dtseries.nii), and dense connectomes (*.dconn.nii). 
 
ConnectomeDB will be the web-accessible database that will handle all HCP data modalities (MR 
images, MEG/EEG, and behavioral data) and will be central to HCP data mining.  Once operational, 
ConnectomeDB will be accessible from any web browser (see URL below) and also in an internal browser 
within Workbench using the DB button in the Tools section of the Toolbar. (See IntraDB for Phase I HCP 
data access.) 
 
Deformation map file (*.deform_map) is a file type that allows transformation of data from one surface 
mesh (e.g., an individual subject’s ‘initial mesh’) to another surface mesh (e.g., the fs_LR atlas mesh).   
The key step in creating a deformation map is to encode the relationship between each node in one 
sphere (the ‘deformed source sphere’) and the nearest surface tile in the ‘target sphere’.  A deformation 
map can also be used to resample a surface from one mesh density (e.g., a ‘164k’ mesh) to another (e.g., 
a ‘32k’ mesh), as done for this tutorial.  (See Van Essen et al., 2011a, 2011b for additional details on 
deformation maps and surface-based registration.)  
 
Deformed data file is a file that has been operated on by a deformation map file, for instance when 
registering it from a source to a target surface.  By default, the expression ‘deformed_’ is prepended to 
the file name and to the column name after applying a deformation map, but this can be modified as 
specified by the user or within the deformation map file. 
 
Dense Connectome refers to connectivity matrix CIFTI files that contain correlations between every 
surface or volume brainordinate and every other surface or volume ordinate in our model of the brain. 
For example, a grayordinates × grayordinates dense connectome file contains a connectivity value 
between every grayordinate and every other grayordinate.  Because dense connectivity files can be very 
large (~32.5 GB for HCP-generated dense connectomes), it is noteworthy that they can be accessed 
interactively by reading out only one row at a time or an average across a user-selected subset of rows, 
as needed, from a file that is stored remotely (e.g., in the ConnectomeDB database). Dense 

http://www.humanconnectome.org/
https://wiki.humanconnectome.org/display/aWB/Workbench+Glossary#WorkbenchGlossary-Whiteordinate
http://www.nitrc.org/projects/cifti/
http://cercor.oxfordjournals.org/content/early/2011/11/02/cercor.bhr290.long
http://cercor.oxfordjournals.org/content/early/2011/11/02/cercor.bhr291.long
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connectomes can also be asymmetric, such as a structural connectivity matrix between grayordinates 
(all gray matter structures) and whiteordinates (all white matter structures).   
 
Dense label CIFTI files (grayordinates × label maps) contain a name and/or color label for every 
brainordinate. These files will be useful for mapping combined cortical and subcortical parcellations.  
 
Dense scalar CIFTI files contain real-valued data for every brainordinate mapped to a color palette. A 
dense scalar file can contain one map or frame (such as a single cortical myelin map) or a series of 
spatial maps (e.g. tfMRI contrast maps or ICA component spatial maps) that can have distinct labels for 
each frame.    
 
Dense time series is a type of dense scalar CIFTI file (grayordinates × time) that can be viewed as a 
series of maps (or animated movie) displayed on cortical surfaces and subcortical volume slices or as a 
timecourse graph for a selected grayordinate, using the timecourse graph window (and as an average 
timecourse for all grayordinates within a selected ROI).  This type of file is particularly useful for viewing 
resting state fMRI time series.  
 
Features Toolbox refers to the section of the Workbench Window that allows the user to select and set 
display attributes for Features such as Borders and Foci in the current Active Viewing tab.  
 
GIFTI file is a file format for surface representations that is supported by many major brain mapping 
visualization platforms (http://www.nitrc.org/projects/gifti). 
 
Grayordinate is a brain gray matter location that can be represented by a surface vertex (node) or a 
volume voxel.   
 
ConnectomeDB is the web-accessible database for HCP data. To get an account for ConnectomeDB, go 
to: http://humanconnectome.org/data/and register for access. 
 
Menu bar refers to the gray bar containing pull-downs (menus) of program-wide functions located at 
the very top of the screen (Mac) or at the top of the Workbench Window (PC and Linux). Menu items 
include File, View, Data, Surface, Volume, Window and Help. 
 
NIFTI file (*.nii and *nii.gz) is a standard file format for volumetric data that is widely used in 
neuroimaging.  The original NIFTI-1 file format was based on 16-bit signed integers and was limited to 
32,767 in each dimension. The NIFTI-2 format (http://www.nitrc.org/forum/message.php?msg_id=3738) 
is based on 64-bit integers and can handle very large volumes and matrices. 
 
Overlay Toolbox refers to the section of the Workbench Window that allows the user to set the data to 
be displayed on the structure in the active tab.  
 
Parcellation refers to the division of the cerebral cortex and subcortical volume into regions that share 
functional or structural properties.  
 

http://www.humanconnectome.org/
http://humanconnectome.org/data/
http://www.nitrc.org/forum/message.php?msg_id=3738
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Scene refers to the current state (settings and files being visualized) within Workbench. You can save 
these settings globally in a scene file, which allows you to re-access your current Workbench session at a 
later time. By reopening a saved scene file, a user can “pick up where they left off” when they reopen 
Workbench.  
 
Specification File (commonly called “Spec File”) is a file used to organize a set of data files (such as 
volume, label, and metric files) to be loaded into Workbench.  
 
Splash Screen is the first window that opens upon launching Workbench that serves as a title page and 
shortcut for opening Spec files. It contains a list of Spec files in your current path and those that have 
been recently opened that can be selected and opened in one step. It also contains links to the HCP 
website and Twitter feed.    
 
Montage is a viewing mode in which lateral and medial views of both left and right hemispheres are 
shown in a single viewing area and can be rotated in tandem for a full surface view of the brain. 
 
Tab Montage is a setting that displays the images from all of the tabs you have open in the current 
Workbench Window in one Viewing Area.  All the surfaces and/or volumes displayed in Tab Montage 
can still be manipulated with the mouse controls (rotate, zoom, pan).  This option allows you to view 
and compare multiple structures and datasets at once. Access tab montage from the View►Screen 
menu, or through the keyboard shortcut: command + M (Mac) or control + M (PC/Linux).   
 
Toolbar refers to the section at the top of the Workbench Window that contains viewing settings for the 
structure you are displaying in the current tab and access to Workbench functional modes (border 
drawing, region of interest definition, etc.).  
 
A Tooltip is pop-up information on Workbench functions that appears when you hover your cursor over 
a button or pull-down menu.  These are found throughout the entire Workbench for easy access to 
explanations of the functions of buttons and menus.  
 
Viewing Area refers to the field of the Workbench Window where images of the surface, volume or 
whole brain are displayed.  The default background is set to black, but this can be changed to any color 
in the Preferences.  
(Menu bar►Workbench►Preferences►Colors►Set Background…) 
 
Viewing Tabs refer to the set of viewing workspaces within a Workbench Window. Each tab contains an 
independent Toolbar, Viewing Area, and Toolbox. To navigate between Viewing Tabs, click on the tab 
name or press command-(Mac)/control-(PC/Linux) and the left and right arrow buttons. To remove a 
tab, click on the ‘X’ button to the right of the tab name. Further tab options are available in the Window 
menu. 
 
Volume Montage is a setting available in Volume views that displays a series of slice images in the 
Viewing Area.  Settings for the number of columns and rows, and the step number (stereotactic space 
between) of slices being viewed for this montage of images are located in the Toolbar.  
 

http://www.humanconnectome.org/
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Whiteordinate is a brain white matter location.  It is generally represented by a list of white matter 
voxels, though in principle, it can also be represented surface vertices (nodes). 
 
Workbench Window refers to the main interface of Workbench, containing the Viewing Tabs, Toolbar, 
Viewing Area and Toolbox. In PC/Linux, the Workbench Window also includes the Menu bar. More than 
one Workbench Window can be opened at one time, either by selecting New Window from the File 
menu or from selections made from the Window menu. 

 

 

http://www.humanconnectome.org/
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